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New Installation Checklist 
The following is a checklist of the overall steps needed to install Costpoint 8.2. Details for each step are 
provided on subsequent pages. (You can print this checklist and use it as you complete this installation.) 

Done? Step Notes 

Database Tier Installation 

 1. Create Costpoint 8.2 Oracle Instance(s) 
and Tablespaces 

 

 2. Install Costpoint Database using Database 
Tier Installer 

 

 3. Apply Partitioning Script for Performance 
Enhancement (optional) 

 

Application Tier Installation  
 1. Install Application Tier Software  

 2. Add Users to the CostpointToolsGroup  

 3. Start Costpoint 8.2  

 4. Install Costpoint 8.2 Windows Service  

 5. Configure Costpoint 8.2 Windows Service  

Web Tier Installation (Microsoft IIS) 
 1. Configure Microsoft IIS for Costpoint 8.2  

 2. Install Web Tier Software  

 3. Add Users to the CostpointToolsGroup  

 4. Configure Costpoint 8.2 IIS Access  

 5. Restart Costpoint 8.2 WebLogic Server  

Using Costpoint 8.2 
 1. Log in to Costpoint 8.2  
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Done? Step Notes 

Maintenance Release Installation 

 1. Install Latest Costpoint 8.2 Maintenance 
Release (MR) 

 

Related Documentation 
The following table lists the additional documentation that downloads with this release. Except where 
noted, all the user guides and quick reference guides listed in this table are also available for download 
from the Deltek Customer Care Connect site. 

You need Adobe Reader 8.2 or higher to view the documents listed in this section. 

Release Notes 

Document Name Description 

Deltek Costpoint 8.2 Database Changes This document describes the database changes 
between the release of Costpoint 8.1 and Costpoint 
8.2. 

Deltek Costpoint 8.2 Release Notes  Major New Features and Enhancements: View the 
major new features and enhancements included in 
Costpoint 8.2. 

De-Supported Applications: View the applications 
that are no longer supported in Costpoint 8.2. 

Entity Relationship Diagrams (ERDs) 

Document Name Description 

DeltekCostpoint820TransactionSchema.zip This ZIP file contains the ERD for the Deltek Costpoint 
8.2 Transaction schema. Use index.htm to view the 
ERD. 

DeltekCostpoint820SystemSchema.zip This ZIP file contains the ERD for the Deltek Costpoint 
8.2 System schema. Use index.htm to view the ERD. 

DeltekCostpoint820AdminSchema.zip This ZIP file contains the ERD for the Deltek Costpoint 
8.2 Admin schema. Use index.htm to view the ERD. 

DeltekCostpoint820PLTransactionSchema.zip This ZIP file contains the ERD for the Deltek Costpoint 
8.2 Planning Transaction schema. Use index.htm to 
view the ERD. 
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Document Name Description 

DeltekCostpoint820TETransactionSchema.zip This ZIP file contains the ERD for the Deltek Costpoint 
8.2 Time & Expense Transaction schema. Use 
index.htm to view the ERD. 

Technical Guides 

Document Name Description 

Deltek Costpoint 8.2 Configuration Utility This document describes how to use the Costpoint 
Configuration Utility, which Costpoint administrators 
use to perform the most common configuration tasks. 

Deltek Costpoint 8.2 Content Management 
Integration 

This document describes how to configure and tune 
the Costpoint Content Management Integration (CMI) 
application to provide access to Microsoft 
SharePoint™, as well as other Content Management 
Systems (CMS) that are compliant with the Content 
Management Interoperability Standard (CMIS). 

Deltek Costpoint 8.2 DB Wizard Utility This document describes how administrators use the 
DB Wizard utility to apply licenses, run link views, 
rebuild user menus, and deploy and verify 
extensibility. 

Deltek Costpoint 8.2 Deployment Options 
Technical Overview 

This document provides a high-level overview of 
Costpoint configuration options, including server, 
database, and security options. 

Deltek Costpoint 8.2 Integration Overview This document provides a high-level overview of how 
Costpoint reports, processes, and data can be 
integrated with third-party applications via Web 
services. 

Deltek Costpoint 8.2 Integration Console This document is a detailed guide to the Costpoint 
Integration Console, which automates the process of 
integrating Costpoint reports, processes, and data 
with third-party applications via Web services. 

Deltek Costpoint 8.2 Maintenance Release 
Installation Guide 

This document describes how to apply Costpoint 8.2 
maintenance releases. 

Deltek Costpoint 8.2 Message Boards This document describes how integration between 
Costpoint and MS Exchange can enable collaboration 
among Costpoint users as well as between Costpoint 
and non-Costpoint users. Integration also enables you 
to link emails with attachments directly to Costpoint 
documents and view them directly from Costpoint. 
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Document Name Description 

Deltek Costpoint 8.2 Monitoring Utility This document describes how to use the Monitoring 
Utility to diagnose Costpoint configuration problems. 

Deltek Costpoint 8.2 Performance 
Optimization 

This document contains Costpoint performance tips 
and tricks, information on the configuration of the 
Deltek performance lab, and a list of optimized 
applications for the Oracle parallel SQL execution 
option. 

Deltek Costpoint 8.2 Post Installation 
Hardening Guide 

This document presents common principles and 
recommendations that administrators should consider 
for post-installation hardening of the Costpoint server 
environment. 

Deltek Costpoint 8.2 Process Execution 
Modes 

This document describes the many options for 
executing reports and processes in Costpoint, 
including using interactive and batch modes and job 
servers. 

Deltek Costpoint 8.2 Security This document describes user authentication and 
other security safeguards in Costpoint. 

Deltek Costpoint 8.2 User Migration Utility This document describes how to migrate users from 
earlier Costpoint versions to Costpoint 8.2. 

Other Documents 

Document Name Description 

Deltek Costpoint 8.2 Getting Started Guide This document provides instructions for accessing 
Costpoint applications and describes menus, toolbars, 
and other global features. You will also find 
information about logging on to Costpoint, accessing 
the database, printing reports, reviewing online help, 
and contacting Deltek Customer Care and other client 
services. 

Deltek Costpoint 8.2 User Interface QRC This document is a quick reference card that 
describes how to navigate through the application. 

Deltek Costpoint 8.2 Shortcut Keys Toolbar 
Icons And Buttons QRC 

This document is a quick reference card that lists the 
shortcut keys available in Costpoint, as well as the 
toolbar icons and buttons. 

Deltek Costpoint 8.2 Views QRC This document is a quick reference card that explains 
the differences between Table View and Form View. 
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Document Name Description 

Deltek Costpoint 8.2 Query and Lookup QRC This document is a quick reference card that explains 
how to use the query and lookup functions in 
Costpoint. 

Deltek Costpoint 8.2 Extensibility Designer 
Coding Guide 

This document contains java coding information for 
Costpoint Extensibility developers. 

Deltek Costpoint 8.2 Extensibility Designer 
Quick Start Guide 

This document outlines the basic steps for creating 
and deploying extensibility. 

Deltek Costpoint 8.2 Extensibility Designer 
Report Guide 

This document describes how to extend a report. 

Deltek Costpoint 8.2 Extensibility Designer 
User Guide 

This document contains detailed instructions for using 
the Costpoint Extensibility Designer. 

Deltek Costpoint 8.2 Screen Customization 
and Business Logic Extensibility 

This document provides an overview of Costpoint 
screen customization and business logic extensibility 
features. 
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New Installation Overview 
This document provides instructions for installing the Deltek Costpoint 8.2 software. During the installation 
process, you will perform the following actions: 

 Ensure that your system meets the installation prerequisites. 

 
 Install the Costpoint 8.2 Database Tier software to create your Costpoint 8.2 Transaction, 

System, and Admin databases, as well as your Costpoint 8.2 Planning (PL) Transaction and Time 
& Expense (TE) Transaction databases (if applicable). 

 Install the Costpoint 8.2 Application Tier software, which includes both the Oracle WebLogic® 
Server software and the Costpoint 8.2 software. 

 Install the Costpoint 8.2 Web Tier software to your Internet Information Server, if applicable. 

 Install the latest Costpoint 8.2 Maintenance Release (MR). 

 

Installation Package Contents 
The Costpoint 8.2 installation package contains the following: 

 Costpoint 8.2 Database Tier installer 

 Costpoint 8.2 Application Tier installer 

 Costpoint 8.2 Web Tier installer 

 Costpoint 8.2 Maintenance Release Installer 

 Deltek Costpoint 8.2 New Installation Guide for Oracle 

 Deltek Costpoint 8.2 Maintenance Release Installation Guide 

Installation Prerequisites 

Database Tier Installation Prerequisites 
Before you start the Database Tier installation process, your database server must meet the following 
software prerequisite: 

Prerequisite 
Component Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix, which is available on the Customer Care 
Support Site here. 

Note: See the Installation Prerequisites and System Requirements sections for additional 
information, and review the full list of Related Documentation prior to installing Costpoint 8.2. 

Note: If you need help with this installation, contact Deltek Costpoint Technical Support at 
877.HLP.PROJ (877-457-7765). 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Prerequisite 
Component Details 

Passwords To run the installation, passwords are required for Oracle SYSTEM and 
SYS users. 

Oracle Instance and 
Tablespaces 

Create an Oracle instance and Oracle tablespaces as documented in 
Create Costpoint 8.2 Instance(s) and Tablespaces. 

Firewall Settings On your Database Server, the Oracle Listener Port (1521) must be open 
for Inbound and Outbound traffic through your firewall. 

On your Database Server, make sure that the Network discovery and file 
sharing options are switched on. 

Application Tier Installation Prerequisites 
Before you start the Application Tier installation process, the application server that will run your 
WebLogic Server and Costpoint 8.2 software must meet the following prerequisites: 

Prerequisite 
Component Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available, which is available on the Customer 
Care Support Site here. 

Costpoint 8.2 Server Startup Prerequisites 
Before you start Costpoint 8.2, the following requirements must be met: 

Prerequisite 
Component Details 

Server 

 

On your Database Server, the Oracle Listener Port 1521 must be open for 
Inbound and Outbound traffic through your firewall. 

On your Database Server, make sure that the Network Discovery and 
File Sharing options are switched on. 

On your Application Server, the WebLogic Listener Port 7009 must be 
open for Inbound and Outbound traffic through your firewall. 

On your Application Server, make sure that the Network Discovery and 
File Sharing options are switched on. 

https://deltek.custhelp.com/app/answers/detail/a_id/38499


New Installation Overview 

New Installation Guide for Oracle® 8 

 

Costpoint 8.2 Initial Log In Configuration Prerequisites 
Before you can log in to Costpoint 8.2, your Windows client computer must meet the following 
requirements: 

Prerequisite 
Component Details 

Software 

 

All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support Site 
here. 

Adobe Reader 2020.xxx or higher: This is required only for users who 
want to print Costpoint 8.2 reports in PDF format. Make sure that you 
select the Display PDF in browser option under the Preference settings 
for Adobe Acrobat Reader to avoid pulling up a blank browser screen 
when printing in PDF format. 

Web Tier Installation/Microsoft Internet Information Server (IIS) 
Configuration Prerequisites 
The web server that will host your Internet Information Server software must meet the following 
prerequisites: 

Prerequisite 
Component Details 

Software 

 

All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support Site 
here. 

Installation Process for Costpoint 8.2 
The Costpoint 8.2 installation process incorporates the following steps:  

Component Change Details 

Database Tier Installation The Database Tier installer automatically creates the following user-
defined schemas and users: 

 Transaction Schema (CPTRAN) 

 Admin Schema (CPADMIN) 

 System Schema (CPSYSTEM) 

 PL Transaction Schema (PLTRAN), if applicable 

 TE Transaction Schema (TETRAN), if applicable 

 Link User (CPLINK_USER) 

Application Tier 
Installation 

The Install function in the Application Tier automatically installs all 
necessary software and handles all configurations.  

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Component Change Details 
The Application Tier installer automatically performs all the following 
actions: 

 Extracting JDK 

 Installing WebLogic 

 Extracting BIRT Lib Files 

 Extracting App Tier Class Files 

 Updating Config Files 

 Encrypting Passwords 

 Running LinkViews 

 Syncing Sys Settings Table 

 Applying License 

 Running LinkViews 

 Migrating Org Security Application Modules 

 Creating Demo License 

 Creating Shortcuts 

The Application Tier installer creates a CostpointToolsGroup with the 
following Sharing and Security permissions: 

 Full Sharing and Security Permissions on your Costpoint 8.2 Deltek 
directory (C:\Deltek)  

 Full Security Permissions on your WebLogic directory 
(C:\Oracle\Middleware14.1.1)  

Web Tier Installation The Install function in the Web Tier automatically installs all necessary 
software and handles all configurations.  

The Web Tier installer automatically performs all of the following actions: 

 Extracting DEProxy Files 

 Extracting DEWebApp Files 

 Configuring Internet Information Server (IIS) 

 Resetting Internet Information Server (IIS) 

The Web Tier installer creates a CostpointToolsGroup with the following 
Sharing and Security permissions: 

 Full Sharing and Security Permissions on the folder containing your 
Costpoint 8.2 DEWebApp directory (C:\Deltek\Costpoint or 
C:\Deltek\Costpoint\82\applications) 

  



New Installation Overview 

New Installation Guide for Oracle® 10 

 

Web Servers Supported in Costpoint 8.2 
The Costpoint 8.2 system supports the following web servers only: 

 Microsoft Internet Information Server  

 Oracle’s WebLogic Web server 

Naming Conventions 
The naming conventions specified in this section are used in all installation instructions detailed in this 
upgrade installation guide. 

Drive Letters 
The following table lists the drive letters used in the installation instructions: 

Drive Description 

C: This is the drive where the Costpoint 8.2 software is installed. 

Directory Names 
The following table lists the directory names used in the installation instructions: 

Directory Name Description 

ORACLE/MIDDLEWARE14.1.1 This is the name of the directory where the Oracle WebLogic 
software is installed. 

DELTEK This is the name of the directory where the Costpoint 8.2 software is 
installed. 

Costpoint Schema Names 
The following table lists typical Oracle schema names used in the Costpoint Database Tier installation: 

Database Name Description 

CPTRAN This is the name of your Costpoint Transaction schema. 

CPSYSTEM This is the name of the Costpoint System schema. The CPSYSTEM user is a 
separate database schema that stores the metadata that the Costpoint 8.2 
software needs to function properly. 

CPADMIN This is the name of the Costpoint Admin schema. The CPADMIN user is a 
separate database schema that stores system and security information that the 
Costpoint 8.2 software needs to function properly. 

PLTRAN This is the name of your Planning Transaction schema. 

TETRAN This is the name of your Time & Expense Transaction schema. 
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Deltek Software Manager (DSM) 
Software installations, installation instructions, technical guides, and release notes are available for 
download from the Deltek Software Manager (DSM). You will also download future releases of Costpoint 
8.2 from DSM.  

DSM is the sole download source for hotfix files. Deltek Knowledge Base articles provide an explanation 
of the fixes and contain links to DSM for retrieval of the actual files. 

DSM Requirements 
You can run DSM from any desktop. You do not need to run DSM from Deltek application servers.  

To run DSM, you must meet the following requirements: 

 Windows XP or later 

 Microsoft .NET Framework 3.5 SP1 (3.5.1) 

The following Deltek Knowledge Base article contains a download link to the framework. It also has 
examples of what you may see if you do not have the framework installed: 
https://deltek.custhelp.com/app/answers/detail/a_id/52469 

 

DSM Documentation and Troubleshooting 
 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

This link works only when you are logged in to Deltek Customer Care Connect. 

Knowledge Base Documentation 

To view Knowledge Base articles: 
1. Go to http://www.deltek.com and click Support Login. 

2. Enter your logon credentials in the following fields, and then click Log In: 

Field Name Description 

Username Enter your Support user name. 

Password Enter your Support user password. 

If you have forgotten your username or password, click Account Assistance.  

If you have forgotten your username, enter your email address and click Email My Username.  

If you have forgotten your password, enter your username and click Reset My Password. 

3. On the Deltek Support Home Screen, click the Knowledge Center tab, complete the following 
fields, and then click Search: 

Tip: Refer to the DeltekSoftwareManager.pdf to learn more about DSM and how it works. 

https://deltek.custhelp.com/app/answers/detail/a_id/52469
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469
http://www.deltek.com/
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Field Name Description 

Refine by Product Select Costpoint from the drop-down list. 

Refine by 
Category/Version 

Expand Service Pack/Hot Fix from the drop-down list, and then select 
8.2 (GA). 

Search Type Use the default value, Phrases, or select your preferred search type 
from the drop-down list. 

Search by Keyword Enter the specific text you are looking for or leave blank to return all 
records for this version. 

4. On the search results screen, perform the following actions: 

 In the Summary column, click the link for the desired correction. 

 When the desired correction loads, click the links in the Answers section to download the 
files. 

System Requirements 

Components 
Costpoint 8.2 uses the following components: 

 Database Tier: Oracle 

 Application Tier: With integrated WebLogic Server 

 Browser Client: Edge, Chrome, Firefox, Safari 

 Web Tier: Microsoft Internet Information Server (optional) 

 All product compatibility information is maintained in the Deltek Product Support Compatibility 
Matrix available on the Customer Care Support site here. 

System Clocks 
For the Costpoint system to function properly, the system clocks on your WebLogic application server and 
the database server that hosts your Costpoint databases must be synchronized with each other. Failure 
to synchronize your system clocks can result in login and other system problems. 

Hardware Recommendations 
You should have received a hardware recommendations document. For future releases of Costpoint, 
hardware recommendations will be supplied via a Customer Care Knowledge Base article. 

Uninstalling and Reinstalling on the Same Server/VM 
Errors can occur when you uninstall and reinstall Costpoint on the same Server/VM. If you encounter 
problems during a first installation attempt and need to start over, Deltek recommends that you start over 
on a freshly built Server/VM.  

If you are using a VM, taking a snapshot of the VM before you begin the installation offers an easy 
method of returning to a fresh state. 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Compatibility Matrix 
For the most current hardware and software requirements, refer to the Knowledge Base article containing 
the Compatibility Matrix: 

 https://deltek.custhelp.com/app/answers/detail/a_id/38499 

 https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibility
Matrix.pdf 

Costpoint 8.2 Log File Information 
The following table provides information on the log files used by the Costpoint 8.2 system. All of these log 
files are located on the Application Server under the C:\Deltek\Costpoint\82\logs folder. 

File Name Description 

DEServer.log This log file is maintained by the WebLogic server instance. In a 
clustered environment, each server writes to a separate file and the 
file name matches the server name.  

The log records server-specific events such as the startup and 
shutdown of servers, the deployment of new applications, or the 
failure of one or more subsystems. The messages include the time 
and date of the event as well as the ID of the user who initiated the 
event. 

CP_DBConn_DEServer.log This log file lists the activate connections used by the product at a 
given time. To enable this logging, set 
<SYSTEMNAME>.logDBConnectionProfile = true in enterprise 
properties.  

In a clustered environment, each server writes to a separate log file 
and the server name determines the name of the log file.  

CP_DBConn_<Server>.log 

CP_DEServer.log This log file contains application-specific information such as 
performance issues, security issues, and errors encountered while 
running a Costpoint application.  

Each server writes to a separate log file and the server name 
determines the name of the log file.  

CP_<Server>.log 

CP_Security_DEServer.log This log file captures messages generated by the Costpoint Web 
security module. Messages such as invalid login attempts caused by 
problematic user IDs, passwords, or insufficient parameters, as well 
as deactivated user accounts, are captured here.  

In a clustered environment, each server writes to a separate log file 
and the server name determines the name of the log file.  

CP_Security_<Server>.log 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
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File Name Description 

delteke.log This log file contains information that pertains to the entire domain. It 
consolidates log records from all application logs and a subset of 
events recorded in all server logs. All the information gathered is 
written into a single file.  

Not all log messages are written into domain. Only those messages 
that match the defined severity are consolidated. 

service.log This log file contains messages generated by Costpoint Web 
windows service. It helps in troubleshooting issues related to service 
startup, which usually occur during the initial configuration stages.  

In addition to service-related messages, this file contains most of the 
information that is captured in the DEServer.log.  

Therefore, after the initial startup issues are sorted out, Deltek 
recommends that you disable this log by editing the 
InstallCPWebasService.cmd (C:\Deltek\Costpoint\82\bin folder) and 
removing the occurrence of "-log:%CP_ROOT%\logs\service.log".  

If you remove this after installing the service, you will need to 
uninstall and reinstall the service for the changes to take effect. 
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Database Tier Installation 
This section provides instructions and recommendations for creating your Costpoint 8.2 database 
schemas.  

During this installation process, you will install the Costpoint 8.2 Database Tier software and automatically 
perform the following: 

 Create and populate a Costpoint 8.2 Transaction database schema (CPTRAN) to store 
transaction data.  

 Create and populate a Costpoint 8.2 System database schema (CPSYSTEM) to store metadata.  

 Create and populate a Costpoint 8.2 Admin database schema (CPADMIN) to store system and 
security information. 

 Create and populate a Costpoint 8.2 Planning Transaction database schema (PLTRAN) to store 
PL transaction data, if applicable.  

 Create and populate a Costpoint 8.2 Time & Expense Transaction database schema (TETRAN) 
to store TE transaction data, if applicable.  

 

 

Before You Start 
Make sure that you meet all Database Tier Installation Prerequisites. 

Create Costpoint 8.2 Oracle Instance(s) and Tablespaces 
This section details the recommended steps to configure your Oracle instance(s) and set up your 
Costpoint 8.2 database tablespaces. 

You must complete these steps on the Oracle database server(s) that will host your CPTRAN, 
CPSYSTEM, CPADMIN, PLTRAN, and TETRAN database schemas. 

The CPTRAN, CPSYSTEM, CPADMIN, PLTRAN, and TETRAN database schemas can reside in the 
same Oracle database or separate Oracle databases on the same or separate Oracle database servers. 

To create the instance(s) and tablespaces that will host your CPTRAN, CPSYSTEM, CPADMIN, 
PLTRAN, and TETRAN database schemas: 

1. Use your Oracle database software to create an Oracle instance (or instances) for hosting the 
Costpoint database. 

The following tables provide references for creating your Oracle instance(s). These initial settings 
are only minimal recommendations. Your production environment may need to be analyzed and 

Note: If you use Oracle Real Application Clusters (RAC) and you have two or more Oracle instances, 
make sure that your CPTRAN, CPADMIN, CPSYSTEM, PLTRAN, and TETRAN schemas are all part 
of one RAC database instead of physically separate databases. If you have a critical need to use 
separate databases, contact Deltek Support. 

Note: The Costpoint platform does not currently support Unicode Translation Format (UTF) character 
sets, such as AL32UTF8. When you configure your Oracle database using Oracle tools, make sure 
that you choose the non-unicode character set, WE8MSWIN1252, when you create your initial 
Costpoint database. 
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adjusted to meet your specific requirements. You must customize these parameters over time 
based on database size, concurrent users, workload, and so on to achieve optimal performance. 

Oracle Instance Parameter Value 

cursor_sharing EXACT 

db_block_size 8192 

dml_locks 1500 

java_pool_size 64 MB 

job_queue_processes 2 

log_checkpoint_interval 10000 

log_checkpoint_timeout 1820 

open_cursors 3000 

optimizer_index_caching 0 

optimizer_index_cost_adj 100 

optimizer_mode ALL_ROWS 

processes 500 

session_cached_cursors 1500 

timed_statistics TRUE 

sga_target 0 

pga_aggregate_target 0 

statistics_level Typical 

db_file_multiblock_read_count 16 

memory_target Based on database size (4 GB to 50 GB) 

memory_max_target Based on database size (4 GB to 50 GB) 

pga_aggregate_limit 0 
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Tablespace 
Configuration Type Tablespace Name 

Minimum Size 
(MB) 

Small Production 
System (MB) 

System SYSTEM 100 100 

Default COSTPOINT_DATA 200 500 

Index COSTPOINT_INDEX 100 300 

Default TE_DATA 100 300 

Index TE_INDEX 100 300 

Default PL_DATA 100 300 

Index PL_INDEX 100 300 

Dynamic COSTPOINT_DYN 100 300 

Temporary TEMPORARY_DATA 100 400 

2. For databases over 50GB, Deltek recommends the following additional tablespaces for optimal 
performance. 

These initial settings are only minimal recommendations. Your production environment may need 
to be analyzed and adjusted to meet your specific requirements. 

Recommended Customization 
Tablespace Configuration Type Tablespace Name 

Minimum 
Size (MB) 

Small 
Production 
System (MB) 

Temporary Data COSTPOINT_XZDATA 512 2048 

Temporary Index COSTPOINT_XZINDEX 256 1024 

Report Data COSTPOINT_RPTDATA 1024 5120 

Report Index COSTPOINT_RPTINDEX 512 2048 

 

Recommended Tablespace 
Configuration Type for 
CPSYSTEM and CPADMIN Tablespace Name 

Minimum 
Size (MB) 

Small 
Production 
System (MB) 

System SYSTEM 450 450 

Default CPMETA_DATA 400 400 

Index CPMETA_INDEX 100 100 

Temporary TEMPORARY_DATA 100 100 
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Configuring Multiple Costpoint Transaction Schemas with 
Shared CPADMIN/CPSYSTEM Schema(s) 

 
If you want to share your Costpoint CPSYSTEM and /or CPADMIN schemas across multiple Costpoint 
Transaction schemas and the schemas reside on different databases—or on separate database 
servers—it is necessary to configure all the Oracle databases in shared server configuration mode (also 
called Oracle multi-threaded server [MTS]). 

An Oracle database creates server processes to handle incoming requests from user processes from 
client machines. A server process is called a dedicated server process when it services, and is dedicated 
to, only one user process at a time. This is the default configuration for all Oracle databases. A shared 
server process can service multiple user process requests in shared server architecture, thus reducing 
the total number of server processes needed to service a given workload. This enables a significant 
reduction in system resources and supports an increased number of concurrent users. 

The following recommendation is just the starting point on how to configure your database with shared 
server architecture. It is important to understand your system configuration, number of concurrent users, 
server load, network load, and so on and adjust these settings for optimal performance. There are other 
parameters available that can be adjusted, depending on your Oracle RDBMS version. 

 The DISPATCHERS initialization parameter configures dispatcher processes in shared server 
architecture. Execute the following statement in SQL Plus: 

ALTER SYSTEM SET DISPATCHERS = '(PROTOCOL=TCP) (DISPATCHERS=2)'; 
 The SHARED_SERVERS initialization parameter specifies the minimum number of shared 

servers created at instance startup. Execute the following statement in SQL Plus: 

ALTER SYSTEM SET SHARED_SERVERS = 5; 
Setting this parameter to 0 disables shared server architecture. 

 

Configuring Costpoint on Oracle 
Costpoint 8.2 supports both Oracle database architectures: non-CDBs as well as Oracle Multitenant 
(PDBs). 

Costpoint 8.2 fully supports use of pluggable databases (PDBs) that form a part of a container database 
(CDB). When hosting a Costpoint database as a PDB, it is important to allocate adequate shared 
resources and/or limit the number of PDBs in the CDB in order to achieve and maintain optimal 
application performance. The database setup and configuration with Oracle multitenant will vary 
depending on the database workload characteristics, database size, concurrent users, and so on. 

 

Note: You can skip this step if you do not want to share your CPADMIN or CPSYSTEM schemas 
across multiple Costpoint systems. 

Note: For more information on Oracle shared server architecture, see the Oracle documentation for 
your RDBMS version. 

Tip: Costpoint 8.2 does not support use of the domain name as a suffix for the Oracle service name.  
For example, Costpoint 8.2 does not support orc1.domain.com as your service name. 
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Install the Database Tier Software 
This section details the steps to install the Costpoint 8.2 Database Tier software as well as create the 
Transaction, System, and Admin databases. 

You must complete these steps on your database server or from a client workstation with Oracle client 
connectivity tools installed to connect to the database.  

You must have Internet access on the machine where the Costpoint 8.2 installer is invoked in order to 
download the latest DeltekCostpoint82DatabaseNewInstallationFiles.exe and 
DeltekCostpoint82RequirementsINI.exe files automatically.  

 The DeltekCostpoint82DatabaseNewInstallationFiles.exe file contains the latest special 
characters supported for user, password, and other fields in the installer.  

 The DeltekCostpoint82RequirementsINI.exe file contains the latest OS platforms and database 
versions supported.  

These files are automatically downloaded when you launch the Database Tier installation, assuming that 
your database server has Internet access.  

 
If your database server does not have Internet access, you must perform the steps in the Latest Installer 
Files Download Instructions section of this document before you run the 
DeltekCostpoint82DatabaseTier.exe file. 

To install the Database Tier software: 
1. Run the DeltekCostpoint82DatabaseTier_Buildxx.exe file to launch the Costpoint 8.2 

Database Tier installation program. 

 
2. On the Welcome to the InstallShield Wizard for Deltek Costpoint Database screen, click Next >.  

3. On the Select the Database Type screen, select Oracle, and click Next >.  

4. On the Choose Destination Location screen, click Browse to navigate to an installation location 
for the Costpoint 8.2 Database Tier software, and click Next >.  

The default installation location is C:\Deltek\Costpoint\82\Database\Scripts (recommended). 

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server.  

To improve security, these connections have been modified to require communication over HTTPS. 

Note: Due to enhanced security in Microsoft Windows Server, Deltek recommends that you 
use the Run as Administrator option when launching installation files, even if you are 
logged in as a user with local administrative rights.  

To do this, right-click the DeltekCostpoint82DatabaseTier.exe file in Windows Explorer and 
select Run as Administrator. 
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5. On the Features screen, select from the following: 

Field Name Action 

Costpoint Oracle 
Databases 

Select this feature to install and configure the Costpoint Transaction, 
System, and Admin database schemas and users. 

Time & Expense 
Oracle Database 

Select this feature to install and configure the Time & Expense 
Transaction database schema and user. 

Planning Oracle 
Database 

Select this feature to install and configure the Planning Transaction 
database schema and user. 

6. On the Oracle Home Information screen, from the drop-down list, select the Oracle Home 
location for your Costpoint database, and click Next >.  

The installer reads your registry to display all available Oracle Home locations. 

7. On the Costpoint Oracle TRANSACTION Database Information screen, complete the following 
fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 Transaction (CPTRAN) 
database server. The default value is your computer name. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

- _ 
The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. If you have SCAN listener set up, use the Scan 
hostname or Scan IP Address. Do not use the Virtual IP Address. 

Service Name Select SID or Service Name, and then enter the system identification 
name (SID) or Service Name (ORC1) for the Oracle instance where your 
Costpoint Transaction database schema will be created. The default is 
PDBORCL.  

In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
Deltek Costpoint requires that the Oracle Database SERVICE_NAME be 
the DB_NAME value only, meaning the DB_DOMAIN value must be 
empty. Therefore, the SERVICE_NAME must use the “dbname” format, 
and not “dbname.dbdomain”. 

Oracle database software identifies a database by its global database 
name. A global database name consists of the database name and 
database domain. The DB_NAME parameter and the DB_DOMAIN 
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Field Name Action 
parameter combine to create the global database name value assigned 
to the SERVICE_NAMES parameter in the initialization parameter file. 

For databases on Oracle 12c, you must select Service Name. 

For databases on other Oracle versions, you can choose either the SID 
or the Service Name to connect to the Costpoint database.  

The Oracle SID pertains to the unique name that identifies an Oracle 
instance. If you use SID, then the SID must be registered with the 
listener on the database server hosting the Costpoint database. 

Similarly, if you enter a Service Name, then the Service Name must be 
a valid service registered with the listener on the database server 
hosting the Costpoint database. 

For RAC installations, you can specify the Oracle Instance (SID) of one 
of the instances, or use the Service Name, depending on your Oracle 
RDBMS version. 

Port Enter the Oracle listener port of your Costpoint database server. The 
default port for Oracle is 1521. 

Transaction 
Database User 
(Schema) 

Enter the name for your Transaction schema user account. The default 
is CPTRAN. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your Transaction schema user account. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Transaction 
Database Confirm 
User Password 

Re-enter the password for your Transaction schema user account. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your Oracle SYSTEM user. The default is SYSTEM. If 
a user with “sysadmin” privileges is available, you can instead specify 
that user. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ # 
For the Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user)—you enter a case-sensitive 
username. If the case does not match, the installer will fail in the link 
view step even though the connection validation on the initial screens 
will be successful. 
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Field Name Action 

Oracle SYSTEM 
User Password 

Enter the password for your Oracle SYSTEM user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

8. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays:  

“CPTRAN will be created. Click Next.” 

If the message above does not display, correct the connection information and click Test 
Connection again. 

9. When you receive the message confirming a successful connection, click Next >.  

10. On the Costpoint Oracle ADMIN Database Information screen, complete the following fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 Admin (CPADMIN) database 
server. The default value is your computer name. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

- _ 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. If you have SCAN listener set up, use the Scan 
hostname or Scan IP Address. Do not use the Virtual IP Address. 

Service Name Select SID or Service Name, and then enter the system identification 
name (SID) or Service Name (ORC1) for the Oracle instance where your 
Costpoint Admin database schema will be created. The default is 
PDBORCL. 

In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
Deltek Costpoint requires that the Oracle Database SERVICE_NAME be 
the DB_NAME value only, meaning the DB_DOMAIN value must be 
empty. Therefore, the SERVICE_NAME must use the “dbname” format, 
and not “dbname.dbdomain”. 

Oracle Database software identifies a database by its global database 
name. A global database name consists of the database name and 
database domain. The DB_NAME parameter and the DB_DOMAIN 
parameter combine to create the global database name value assigned 
to the SERVICE_NAMES parameter in the initialization parameter file. 
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Field Name Action 
For databases on Oracle 12c, you must select Service Name. 

For databases on other Oracle versions, you can choose either the SID 
or the Service Name to connect to the Costpoint database. The Oracle 
SID pertains to the unique name that identifies an Oracle instance. If you 
use SID, then the SID must be registered with the listener on the 
database server hosting the Costpoint database. 

Similarly, if you enter a Service Name, then the Service Name must be 
a valid service registered with the listener on the database server 
hosting the Costpoint database. 

For RAC installations, you can specify the Oracle Instance (SID) of one 
of the instances or use the Service Name, depending on your Oracle 
RDBMS version. 

Port Enter the Oracle listener port of your Costpoint database server. The 
default port for Oracle is 1521. 

Admin Database 
User (Schema) 

Enter the name for your Admin schema user account. The default is 
CPADMIN. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 

Admin Database 
User Password 

Enter the password for your Admin schema user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Admin Database 
Confirm User 
Password 

Re-enter the password for your Admin schema user account. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your Oracle SYSTEM user. The default is SYSTEM. If 
a user with “sysadmin” privileges is available, you can instead specify 
that user. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ # 
For the Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user)—you enter a case-sensitive 
username. If the case does not match, the installer will fail in the link 
view step even though the connection validation on the initial screens 
will be successful. 

Oracle SYSTEM 
User Password 

Enter the password for your Oracle SYSTEM user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 
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11. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays:  

“CPADMIN will be created. Click Next.” 

If the message above does not display, correct the connection information, and click Test 
Connection again. 

12. When you receive the message confirming a successful connection, click Next >.  

13. On the Costpoint Oracle SYSTEM Database Information screen, complete the following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 System (CPSYSTEM) 
database server. The default value is your computer name. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

- _ 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. If you have SCAN listener setup, please use the 
Scan hostname or Scan IP Address. Do not use the Virtual IP Address. 

Service Name Select SID or Service Name, and then enter the system identification 
name (SID) or Service Name (ORC1) for the Oracle instance where your 
Costpoint System database schema will be created. The default is 
PDBORCL. 

In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
Deltek Costpoint requires that the Oracle Database SERVICE_NAME be 
the DB_NAME value only, meaning the DB_DOMAIN value must be 
empty. Therefore, the SERVICE_NAME must use the “dbname” format, 
and not “dbname.dbdomain”. 

Oracle Database software identifies a database by its global database 
name. A global database name consists of the database name and 
database domain. The DB_NAME parameter and the DB_DOMAIN 
parameter combine to create the global database name value assigned 
to the SERVICE_NAMES parameter in the initialization parameter file. 

For databases on Oracle 12c, you must select Service Name. 

For databases on other Oracle versions, you can choose either the SID 
or the Service Name to connect to the Costpoint database. The Oracle 
SID pertains to the unique name that identifies an Oracle instance. If you 
use SID, then the SID must be registered with the listener on the 
database server hosting the Costpoint database. 
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Field Name Action 
Similarly, if you enter a Service Name, the Service Name must be a 
valid service registered with the listener on the database server hosting 
the Costpoint database. 

For RAC installations, you can specify the Oracle Instance (SID) of one 
of the instances or use the Service Name, depending on your Oracle 
RDBMS version. 

Port Enter the Oracle listener port of your Costpoint database server. The 
default port for Oracle is 1521. 

System Database 
User (Schema) 

Enter the name for your System schema user account. The default is 
CPSYSTEM. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 

System Database 
User Password 

Enter the password for your System schema user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

System Database 
Confirm User 
Password 

Re-enter the password for your System schema user account. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your Oracle SYSTEM user. The default is SYSTEM. If 
a user with “sysadmin” privileges is available, you can instead specify 
that user. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ # 
For the Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user)—you enter a case-sensitive 
username. If the case does not match, the installer will fail in the link 
view step even though the connection validation on the initial screens 
will be successful. 

Oracle SYSTEM 
User Password 

Enter the password for your Oracle SYSTEM user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

14. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays:  

“CPSYSTEM will be created. Click Next.” 
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If the message above does not display, correct the connection information, and click Test 
Connection again. 

15. When you receive the message confirming a successful connection, click Next >.  

16. On the Time & Expense Oracle TRANSACTION Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Time & Expense 8.2 Transaction (TETRAN) 
database server. The default value is your computer name. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

- _ 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. If you have SCAN listener set up, use the Scan 
hostname or Scan IP Address. Do not use the Virtual IP Address. 

Service Name Select SID or Service Name, and then enter the system identification 
name (SID) or Service Name (ORC1) for the Oracle instance where your 
Time & Expense Transaction database schema will be created. The 
default is PDBORCL. 

In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
Deltek Costpoint requires that the Oracle Database SERVICE_NAME  
be the DB_NAME value only, meaning the DB_DOMAIN value must be 
empty. Therefore, the SERVICE_NAME must use the “dbname” format, 
and not “dbname.dbdomain”. 

Oracle Database software identifies a database by its global database 
name. A global database name consists of the database name and 
database domain. The DB_NAME parameter and the DB_DOMAIN 
parameter combine to create the global database name value assigned 
to the SERVICE_NAMES parameter in the initialization parameter file. 

For databases on Oracle 12c, you must select Service Name. 

For databases on other Oracle versions, you can choose either the SID 
or the Service Name to connect to the Costpoint database. The Oracle 
SID pertains to the unique name that identifies an Oracle instance. If you 
use SID, then the SID must be registered with the listener on the 
database server hosting the Costpoint database. 

Similarly, if you enter a Service Name, the Service Name must be a 
valid service registered with the listener on the database server hosting 
the Costpoint database. 
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Field Name Action 
For RAC installations, you can specify the Oracle Instance (SID) of one 
of the instances or use the Service Name, depending on your Oracle 
RDBMS version. 

Port Enter the Oracle listener port of your Costpoint database server. The 
default port for Oracle is 1521. 

Transaction 
Database User 
(Schema) 

Enter the name for your Time & Expense Transaction schema user 
account. The default is TETRAN. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your Time & Expense Transaction schema user 
account. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Transaction 
Database Confirm 
User Password 

Re-enter the password for your Time & Expense Transaction schema 
user account.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your Oracle SYSTEM user. The default is SYSTEM. If 
a user with “sysadmin” privileges is available, you can instead specify 
that user. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ # 
For the Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user)—you enter a case-sensitive 
username. If the case does not match, the installer will fail in the link 
view step even though the connection validation on the initial screens 
will be successful. 

Oracle SYSTEM 
User Password 

Enter the password for your Oracle SYSTEM user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

17. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays:  

“TETRAN will be created. Click Next.” 

If the message above does not display, correct the connection information, and click Test 
Connection again. 

18. When you receive a message confirming a successful connection, click Next >.  
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19. On the Planning Oracle TRANSACTION Database Information screen, complete the following 
fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Planning 8.2 Transaction (PLTRAN) 
database server. The default value is your computer name. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

- _ 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. If you have SCAN listener setup, please use the 
Scan hostname or Scan IP Address. Do not use the Virtual IP Address. 

Service Name Select SID or Service Name, and then enter the system identification 
name (SID) or Service Name (ORC1) for the Oracle instance where your 
Planning Transaction database schema will be created. The default is 
PDBORCL. 

In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
Deltek Costpoint requires that the Oracle Database SERVICE_NAME  
be the DB_NAME value only, meaning the DB_DOMAIN value must be 
empty. Therefore, the SERVICE_NAME must use the “dbname” format, 
and not “dbname.dbdomain”. 

Oracle Database software identifies a database by its global database 
name. A global database name consists of the database name and 
database domain. The DB_NAME parameter and the DB_DOMAIN 
parameter combine to create the global database name value assigned 
to the SERVICE_NAMES parameter in the initialization parameter file. 

For databases on Oracle 12c, you must select Service Name. 

For databases on other Oracle versions, you can choose either the SID 
or the Service Name to connect to the Costpoint database. The Oracle 
SID pertains to the unique name that identifies an Oracle instance. If you 
use SID, then the SID must be registered with the listener on the 
database server hosting the Costpoint database. 

Similarly, if you enter a Service Name, the Service Name must be a 
valid service registered with the listener on the database server hosting 
the Costpoint database. 

For RAC installations, you may specify the Oracle Instance (SID) of one 
of the instances or use the Service Name, depending on your Oracle 
RDBMS version. 

Port Enter the Oracle listener port of your Costpoint database server. The 
default port for Oracle is 1521. 
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Field Name Action 

Transaction 
Database User 
(Schema) 

Enter the name for your Planning Transaction schema user account. 
The default is PLTRAN. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your Planning Transaction schema user account. 
In addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Transaction 
Database Confirm 
User Password 

Re-enter the password for your Planning Transaction schema user 
account. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your Oracle SYSTEM user. The default is SYSTEM. If 
a user with “sysadmin” privileges is available, you can instead specify 
that user. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ # 
For the Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user)—you enter a case-sensitive 
username. If the case does not match, the installer will fail in the link 
view step even though the connection validation on the initial screens 
will be successful. 

Oracle SYSTEM 
User Password 

Enter the password for your Oracle SYSTEM user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

20. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays:  

“PLTRAN will be created. Click Next.” 

If the message above does not display, correct the connection information, and click Test 
Connection again. 

21. When you receive a message confirming a successful connection, click Next >. 

22. On the Costpoint Oracle Tablespace Information screen, complete the following fields, and click 
Next >. 
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Schema 
Tablespace 
Information Field Name Action 

Costpoint 
TRANSACTION 
Schema 
Tablespace 
Information 

Default Select your default tablespace for the Costpoint 
Transaction Schema.  

Deltek recommends that you use COSTPOINT_DATA 
as the tablespace value. 

Temporary Select your temporary tablespace for the Costpoint 
Transaction Schema.  

Deltek recommends that you use 
TEMPORARY_DATA as the tablespace value. 

Index Select your default tablespace for the Costpoint 
Indexes.  

Deltek recommends that you use the default value, 
COSTPOINT_INDEX, as the tablespace value. 

Temporary Data Select your default tablespace for the Costpoint 
Temporary Data (X_Z_ and Z_ tables).  

Deltek recommends that you use the default value, 
COSTPOINT_DATA, unless your database is over 
50G. In that case, Deltek recommends that you use 
COSTPOINT_XZDATA as the tablespace value. 

Temporary Index Select your default tablespace for the Costpoint 
Temporary Indexes (X_Z_ and Z_ tables).  

Deltek recommends that you use the default value, 
COSTPOINT_INDEX, unless your database is over 
50G. In that case, Deltek recommends that you use 
COSTPOINT_XZINDEX as the tablespace value. 

Reporting Data Select your default tablespace for the Costpoint 
Reporting Data.  

Deltek recommends the default value, 
COSTPOINT_DATA, unless your database is over 
50G. In that case, Deltek recommends that you use 
COSTPOINT_RPTDATA as the tablespace value. 

Reporting Index Select your default tablespace for the Costpoint 
Reporting Indexes.  

Deltek recommends the default value, 
COSTPOINT_INDEX, unless your database is over 
50G. In that case, Deltek recommends that you use 
COSTPOINT_RPTINDEX as the tablespace value. 
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Schema 
Tablespace 
Information Field Name Action 

Costpoint 
ADMIN Schema 
Tablespace 
Information 

Default Select your default tablespace for the Costpoint 
Admin Schema.  

Deltek recommends that you use CPMETA_DATA as 
the tablespace value. 

Temporary Select your temporary tablespace for the Costpoint 
Admin Schema.  

Deltek recommends that you use 
TEMPORARY_DATA as the tablespace value. 

Index Select your default tablespace for the Costpoint 
Admin Schema indexes.  

Deltek recommends that you use CPMETA_INDEX as 
the tablespace value. 

Costpoint 
SYSTEM 
Schema 
Tablespace 
Information 

Default Select your default tablespace for the Costpoint 
System Schema. 

Deltek recommends that you use CPMETA_DATA as 
the tablespace value. 

Temporary Select your temporary tablespace for the Costpoint 
System Schema.  

Deltek recommends that you use 
TEMPORARY_DATA as the tablespace value. 

Index Select your default tablespace for the Costpoint 
System Schema indexes.  

Deltek recommends that you use CPMETA_INDEX as 
the tablespace value. 

23. On the Time & Expense Oracle Tablespace Information screen, complete the following fields, and 
click Next >. 

Schema 
Tablespace 
Information Field Name Action 

Time & Expense 
TRANSACTION 
Schema 
Tablespace 
Information 

Default Select your default tablespace for the Time & 
Expense Transaction Schema.  

Deltek recommends that you use TE_DATA as the 
tablespace value. 

Temporary Select your temporary tablespace for the Time & 
Expense Transaction Schema.  
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Schema 
Tablespace 
Information Field Name Action 

Deltek recommends that you use 
TEMPORARY_DATA as the tablespace value. 

Index Select your default tablespace for the Time & 
Expense Indexes.  

Deltek recommends that you use the default value, 
TE_INDEX, as the tablespace value. 

24. On the Planning Oracle Tablespace Information screen, complete the following fields, and click 
Next >. 

Schema 
Tablespace 
Information Field Name Action 

Planning 
TRANSACTION 
Schema 
Tablespace 
Information 

Default Select your default tablespace for the Planning 
Transaction Schema.  

Deltek recommends that you use PL_DATA as the 
tablespace value. 

Temporary Select your temporary tablespace for the Planning 
Transaction Schema.  

Deltek recommends that you use 
TEMPORARY_DATA as the tablespace value. 

Index Select your default tablespace for the Planning 
Indexes.  

Deltek recommends that you use the default value, 
PL_INDEX, as the tablespace value. 

25. On the Link User Information screen, complete the following fields. 

Field Name Action 

Link User Name Enter the name of your LINK user account. The default value is 
CPLINK_USER. The user (schema) should not exist in the database. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ 

Link User 
Password 

Enter the password for your LINK user account. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 
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Field Name Action 

Link User Confirm 
Password 

Re-enter the password for your LINK user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

26. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays:  

“Link User CPLINK_USER will be created. Click Next.”  

If the above message does not display, correct the connection information and click Test 
Connection again. 

27. When you receive a message confirming a successful connection, click Next >. 

28. On the Start Copying Files screen, review the installation parameters that you have selected: 

 To change any settings, click < Back to go back and make the necessary changes.  

 When you are satisfied with the settings, click Install > to begin the installation. 

Once initiated, the installation process begins and creates the objects needed for Costpoint 8.2. 
Do not interrupt the process. A Windows Command Prompt will be displayed on your screen, 
listing the scripts that are being executed. 

The installation performs the scenarios detailed in the Installation Process for Costpoint 8.2 
section of this document. If any errors are encountered, the installation process will stop and you 
should contact Deltek Technical Support with the details. 

When the installation process completes, the Deltek Costpoint Database - Installation Summary 
Results screen displays the results of the process.  

For each feature that you selected to install, you should see a SUCCESS message. Research 
any FAILED messages or Errors in the applicable detailed log file(s) and report them to Deltek 
Costpoint Technical Support. 

29. Click Next >. 

30. On the InstallShield Wizard Complete screen, complete the following fields. 

Field Name Action 

Launch the 
installer 
summary file 

Select this checkbox to review the summary log file. This log shows the 
same data provided on the previous screen. C:\Program 
Files\Deltek\Costpoint\8.2\ 
Logs\DBTier_Installer\DBTier_Install_SummaryResults.log. 

Launch the 
installer log 
file 

Select this checkbox to review the Deltek Costpoint Database installer log 
file. C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\ 
DBTier_Install.log. 

31. Click Finish to exit the installation. 
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32. Important: Review all log files for any errors or reported issues.  

All errors are captured in the DBTier_Install_ErrorSummaryResults.log, which is available in this 
folder: C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer. 

Before You Continue 
Before you proceed, make sure that: 

 The default Oracle Port (1521) is open for Inbound and Outbound traffic through your firewall.  

 Your Network Discovery and File Sharing options are switched on. 

Apply Partitioning Scripts for Performance Enhancement 
This section details the steps that you complete to apply partitioning scripts to your Costpoint 8.2 
TRANSACTION database schema. 

 
Partitioning for the following Costpoint tables and corresponding indexes is supported with Costpoint 8.2: 

Table Name Index Name 

POOL_SIE_SUPPORT SI_1305 

PSR_FINAL_DATA SI_1822 

PSR_HDR SI_1821 

PROJ_SUM PI_0737 

PROJ_BURD_SUM PI_0736 

RPT_REVENUE_WKS SI_1485 

RPT_PROJ_LAB_SUM SI_1037, SI_1038 

RPT_REV_SUM SI_1218 

RPT_PROJ_TMA SI_0015 

PROJ_MOD_ITD_SUM PK_PROJ_MOD_ITD_SUM_IDX 

RPT_UNBILLED_RSN UI_RT_UBD_RSN_PRFYPDSUCORS_IDX 

RPT_PROJ_UNBILLED SI_RPT_PROJ_UNB_PRFYPDSUCO_IDX 

HS_PROJ PK_HS_PROJ_IDX 

Warning: This is an optional step for clients who run Oracle Enterprise edition licensed with 
partitioning support. All other clients must skip this step. 
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The CostpointPartitionTables.sql file contains scripts for creating partitioned tables and indexes using 
the default partitioning scheme recommended by Deltek. You can choose to change the partitioning 
scheme to suit your requirements. 

If the entire script is executed, for each table, the script completes the following actions: 

 Creates a temporary partitioned table 

 Moves the data from the existing non-partitioned table to the partitioned version 

 Creates local partitioned indexes 

 Drops the original, non-partitioned table 

The partitioned tables and indexes are created in the default Oracle tablespace of the Transaction 
schema (DELTEK). To modify this behavior, or to retain the tablespace settings of the corresponding 
original non-partitioned tables, you must modify the appropriate script by adding the tablespace 
information, where necessary. 

To partition a subset of the tables in the list above, you are expected to modify the script suitably before 
execution. Be sure to make provision for adequate disk space and appropriate tablespace settings before 
executing the script. 

 
If you use this approach, you should include columns in the range criteria in this order: 

1. Fiscal Year  
2. Period  
3. Company ID (if multiple companies are used)   

4. Subperiod  
The sub-partitioning option can be used for Subperiod. Your partitioning model may change over time; for 
example, you will need to update it if your firm starts using multiple companies. 

You must complete these steps on your Costpoint 8.2 Transaction database server. 

To apply the partitioning script: 
1. Click Start » All Programs » SQLPlus. 

2. Connect to your Costpoint 8.2 TRANSACTION database using your Transaction schema 
(DELTEK) user account, and execute the following SQL script: 
CostpointPartitionTables.sql 

The script is located in this folder: 
C:\Deltek\Costpoint\82\Database\Scripts\ORACLE\CP_TRANSACTION\Scripts 

3. Exit SQLPlus. 

Warning: While out-of-the-box partitioning may work well for small to medium customers, Deltek 
strongly recommends that larger customers—or customers with multiple years of data—who need to 
get optimal performance out of Costpoint applications modify the default partitioning scheme to 
include the Fiscal Year and Company ID columns as additional partition parameters on top of the 
columns used by Deltek.  

However, if only one company is configured in (or used in) Costpoint, then you should not include the 
Company ID column. 
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Application Tier Installation 
The Costpoint 8.2 system uses Oracle’s WebLogic Server for its application server tier. During the 
Application Tier installation process, you install the WebLogic Server 14.1.1 application server software 
and the Costpoint 8.2 software. 

The Costpoint 8.2 WebLogic application server must not contain any previous versions of WebLogic. 

Before You Start 
Make sure that you meet all Application Tier Installation Prerequisites. 

Install Application Tier Software 
This step provides instructions for installing Oracle’s WebLogic Server 14.1.1 application server software 
and Deltek Costpoint 8.2 software. 

You must complete these steps on the machine that will serve as your Costpoint 8.2 application server. 

You must have Internet access on the machine where the Costpoint 8.2 installer is invoked in order to 
download the latest DeltekCostpoint82RequirementsINI.exe file automatically. The file contains the latest 
OS platforms and database versions supported. The file is automatically downloaded when you launch 
the Application Tier installation, assuming that your application server has Internet access.  

 
If your application server does not have internet access, you must perform the steps in the Latest Installer 
Files Download Instructions section of this document before you run the 
DeltekCostpoint82ApplicationTier_Buildxx.exe file. 

To install the Application Tier software: 
1. Run the DeltekCostpoint82ApplicationTier_Buildxx.exe file to launch the Costpoint 8.2 

Application Tier installation program.   

 
2. On the Welcome to the InstallShield Wizard for Deltek Costpoint Application screen, click Next >. 

Note: The Deltek product installers contain functionality that enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server.  

To improve security, these connections have been modified to require communication over HTTPS. 

Note: Due to enhanced security in Microsoft Windows Server, Deltek recommends that you 
use the Run as Administrator option when launching installation files, even if you are 
logged in as a user with local administrative rights. 
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3. On the Setup Type screen, complete the following fields, and click Next >. 

Field Name Action 

Primary Application 
Server Tier 

Select this setup type to install both the Oracle WebLogic and Deltek 
Costpoint Application Tier software.  

You must select this option if you are installing Costpoint in a non-
clustered environment or if this will be your Primary Application Server 
Tier in a clustered environment. 

Additional changes are required to configure a clustered environment. 

Secondary 
Application Server 
Tier 

Select this setup type to install only the Oracle WebLogic software. 
The Deltek Costpoint Application Tier software will not be installed.  

You must select this option only when you are configuring a clustered 
environment after your Primary Application Server Tier has already 
been installed. 

4. On the Feature Selection screen, complete the following fields, and click Next >. 

Field Name Action 

Costpoint This feature is automatically selected for you. All variations still require 
Costpoint schema information to be entered. 

Time & Expense Select this feature if you have purchased Time & Expense. 

Planning Select this feature if you have purchased Planning. 

5. On the Oracle WebLogic Installation Directory screen, click Browse… to navigate to an 
installation location for the Oracle WebLogic software, and click Next >.  

The default is C:\Oracle\Middleware14.1.1 (recommended). 

Do not install the WebLogic Server software in a directory path or folder that contains a space. 
The Costpoint 8.2 software will not function properly if the WebLogic Server software is installed 
to a directory path or folder that contains a space.  

6. If you set the Setup Type to Secondary Application Server Tier, the Pre-Installation Summary 
screen displays and you should proceed to step 29 of this procedure. 

7. On the Choose Deltek Costpoint Application Installation Directory screen, navigate to the location 
where you want the Costpoint 8.2 software installed, and click Next >.  

The default directory is C:\Deltek (recommended). 

The directory in which you install the Costpoint 8.2 software cannot be the Oracle WebLogic 
install directory (C:\Oracle\Middleware14.1.1). 

 

Note: If you choose to install to a different drive, Deltek strongly recommends that you use 
the same Deltek default directory (E:\Deltek). 
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8. On the Deltek Costpoint Application License screen, click the Browse… button, navigate to the 
folder containing your Costpoint, Time & Expense, and Planning license(s), select all applicable 
licenses, click Open, and click Next >. 

Example license files: 

Deltek_CP_8_License CP.zip, Deltek_CP_8_License TE.zip, Deltek_CP_8_License PL.zip 
9. On the Select the Database Type screen, select Oracle, and click Next >.  

10. On the Costpoint Oracle TRANSACTION Database Information screen, complete the following 
fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Costpoint 8.2 Transaction (CPTRAN) database server. 
The default value is your computer name. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Service Name Enter the service name (ORC1) for the Oracle instance where your 
Costpoint 8.2 Transaction (CPTRAN) database schema resides. The 
default value is PDBORCL. 

In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
The Service Name must be a valid service registered with the listener on 
the database server hosting the Costpoint database. The Oracle Net 
Connect Descriptor on the client machine uses "Service_Name" in the 
instance portion to specify the database to connect to in the file 
tnsnames.ora. 

Oracle creates one default service with the same name as the SID when 
a database is created. This service registers with the local listener to 
provide access to the database. Customers can choose to create other 
service names as needed. 

For RAC installations, you must specify the Service Name of one of the 
instances. 

Port Enter the port that your Costpoint 8.2 Transaction database server 
software uses to listen for requests. The default port for Oracle is 1521. 

Transaction 
Database User 
(Schema) 

Enter the name of your CPTRAN user. The default is CPTRAN.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ 
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Field Name Action 

Transaction 
Database User 
Password 

Enter the password for your CPTRAN user. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your SYSTEM user. The default is SYSTEM. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ # 
For the Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user)—you enter a case-sensitive 
username. If the case does not match, the installer will fail in the link view 
step even though the connection validation on the initial screens will be 
successful. 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

11. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

12. When you receive a message indicating a successful connection, click Next >.  

13. On the Costpoint Oracle ADMIN Database Information screen, complete the following fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Costpoint 8.2 Admin (CPADMIN) database server. The 
default value is your computer name. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Service Name Enter the service name (ORC1) for the Oracle instance where your 
Costpoint 8.2 Admin (CPADMIN) database schema resides. The default 
value is PDBORCL. 
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Field Name Action 
In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
The Service Name must be a valid service registered with the listener on 
the database server hosting the Costpoint database. The Oracle Net 
Connect Descriptor on the client machine uses "Service_Name" in the 
instance portion to specify the database to connect to in the file 
tnsnames.ora. 

Oracle creates one default service with the same name as the SID when 
a database is created. This service registers with the local listener to 
provide access to the database. Customers can choose to create other 
service names as needed. 

For RAC installations, you must specify the Service Name of one of the 
instances. 

Port Enter the port that your Costpoint 8.2 Admin database server software 
uses to listen for requests. The default port for Oracle is 1521. 

Admin Database 
User (Schema) 

Enter the name your CPADMIN user account. The default user is 
CPADMIN. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ 

Admin Database 
User Password 

Enter the password for your CPADMIN user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your SYSTEM user. The default is SYSTEM.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ # 
For the Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user)—you enter a case-sensitive 
username. If the case does not match, the installer will fail in the link view 
step even though the connection validation on the initial screens will be 
successful. 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 
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14. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

15. When you receive a message indicating a successful connection, click Next >.  

16. On the Costpoint Oracle SYSTEM Database Information screen, complete the following fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 System (CPSYSTEM) 
database server. The default value is your computer name. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Service Name Enter the service name (ORC1) for the Oracle instance where your 
Costpoint 8.2 System (CPSYSTEM) database schema resides. The 
default value is PDBORCL. 

In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
The Service Name must be a valid service registered with the listener on 
the database server hosting the Costpoint database. The Oracle Net 
Connect Descriptor on the client machine uses "Service_Name" in the 
instance portion to specify the database to connect to in the file 
tnsnames.ora. 

Oracle creates one default service with the same name as the SID when 
a database is created. This service registers with the local listener to 
provide access to the database. Customers can choose to create other 
service names as needed. 

For RAC installations, you must specify the Service Name of one of the 
instances. 

Port Enter the port that your Costpoint 8.2 System database server software 
uses to listen for requests. The default port for Oracle is 1521. 

System Database 
User (Schema) 

Enter the name your CPSYSTEM user account. The default user is 
CPSYSTEM. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 
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Field Name Action 

System Database 
User Password 

Enter the password for your CPSYSTEM user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your SYSTEM user. The default is SYSTEM.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ # 
For the Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user)—you enter a case-sensitive 
username. If the case does not match, the installer will fail in the link 
view step even though the connection validation on the initial screens 
will be successful. 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

17. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

18. When you receive a message indicating a successful connection, click Next >.  

19. On the Time & Expense Oracle TRANSACTION Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Time & Expense 8.2 Transaction (TETRAN) database 
server. The default value is your computer name. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 
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Field Name Action 

Service Name Enter the service name (ORC1) for the Oracle instance where your Time 
& Expense 8.2 Transaction (TETRAN) database schema resides. The 
default value is PDBORCL. 

In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
The Service Name must be a valid service registered with the listener on 
the database server hosting the Time & Expense database. The Oracle 
Net Connect Descriptor on the client machine uses "Service_Name" in 
the instance portion to specify the database to connect to in the file 
tnsnames.ora. 

Oracle creates one default service with the same name as the SID when 
a database is created. This service registers with the local listener to 
provide access to the database. Customers can choose to create other 
service names as needed. 

For RAC installations, you must specify the Service Name of one of the 
instances. 

Port Enter the port that your Time & Expense 8.2 Transaction database server 
software uses to listen for requests. The default port for Oracle is 1521. 

Transaction 
Database User 
(Schema) 

Enter the name of your TETRAN user. The default is TETRAN. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your TETRAN user. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your SYSTEM user. The default is SYSTEM. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ # 
For the Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user)—you enter a case-sensitive 
username. If the case does not match, the installer will fail in the link view 
step even though the connection validation on the initial screens will be 
successful. 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 
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20. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information and click Test Connection again.  

21. When you receive a message indicating a successful connection, click Next >.  

22. On the Planning Oracle TRANSACTION Database Information screen, complete the following 
fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Planning 8.2 Transaction (PLTRAN) database server. 
The default value is your computer name. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Service Name Enter the service name (ORC1) for the Oracle instance where your 
Planning 8.2 Transaction (PLTRAN) database schema resides. The 
default value is PDBORCL. 

In addition to standard alphanumeric characters, the following special 
characters (underscore and period) are also supported: 

 _  .   
The Service Name must be a valid service registered with the listener on 
the database server hosting the Planning database. The Oracle Net 
Connect Descriptor on the client machine uses "Service_Name" in the 
instance portion to specify the database to connect to in the file 
tnsnames.ora. 

Oracle creates one default service with the same name as the SID when 
a database is created. This service registers with the local listener to 
provide access to the database. Customers can choose to create other 
service names as needed. 

For RAC installations, you must specify the Service Name of one of the 
instances. 

Port Enter the port that your Planning 8.2 Transaction database server 
software uses to listen for requests. The default port for Oracle is 1521. 

Transaction 
Database User 
(Schema) 

Enter the name of your PLTRAN user. The default is PLTRAN. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ 
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Field Name Action 

Transaction 
Database User 
Password 

Enter the password for your PLTRAN user. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
User 

Enter the name of your SYSTEM user. The default is SYSTEM. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ # 
The Oracle superuser (non-Costpoint user) entered on the installer 
screen to establish link views between Costpoint users—if you use a 
custom user (not the Oracle SYSTEM user), then the user name entered 
is case-sensitive. If the case mismatches, the installer will fail in the link 
view step even though the connection validation on the initial screens will 
be successful. 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

23. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information and click Test Connection again.  

24. When you receive a message indicating a successful connection, click Next >.  

25. On the Link User Information screen, complete the following fields: 

Field Name Action 

Link User Name Enter the name your LINK user account. The default user is 
CPLINK_USER. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 

Link User 
Password 

Enter the password for your LINK user account. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

26. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  
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If it this message does not display, correct the information entered, and click Test Connection 
again.  

27. When you receive a message indicating a successful connection, click Next >.  

28. On the Deltek Costpoint Application System Information screen, complete the following fields, 
and click Next >. 

Field Name Action 

System Name Enter the system name that will be used to log on to the Costpoint 8.2 
system.  

Deltek recommends that you use your Costpoint 8.2 database name, 
DELTEKCP. 

The characters used for the system name must be uppercase and 
alphanumeric. The system name must not contain any special 
characters and must be 16 characters or fewer in length. 

Listen Port Enter the port that your Application Server will use to listen for 
connections. The default value is 7009. 

29. On the Pre-Installation Summary screen, review the installation parameters that you have 
selected: 

 To change any settings, click < Back to go back and make the necessary changes.  

 When you are satisfied with the settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Do not interrupt the 
process. A Windows Command Prompt is displayed on your screen that lists the scripts that are 
being executed. 

The installation performs the scenarios detailed in the Installation Process for Costpoint 8.2, 
Application Tier Installation section of this document. If errors are encountered, the installation 
process stops and you should contact Deltek Technical Support with the details. 

When the installation process completes, the Deltek Costpoint Application Install Summary 
Results screen shows the results of the installation process.  

For each feature that you selected to install, you should see a SUCCESS message. Research 
any FAILED messages or Errors in the applicable detailed log file(s) and report them to Deltek 
Costpoint Technical Support. 

30. Click Next >. 

31. On the InstallShield Wizard Complete screen, complete the following fields. 

Field Name Action 

Launch the 
installer summary 
file 

Select this checkbox to review the summary log file. This will show the 
same data from the previous screen.  

Launch the 
installer log file 

Select this checkbox to review the Deltek Costpoint Application installer 
log file. 

32. Click Finish to exit the installation. 
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33. Important: Review all log files for any errors or reported issues. 

Errors are captured in the AppTier_Install_ErrorSummaryResults.log, which is available in this 
folder: C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer. 

Before You Continue 
Before you proceed, make sure that: 

 Your default Application Server Listener Port (7009) is open for Inbound and Outbound traffic 
through your firewall. 

 Your Network Discovery and File Sharing options are switched on. 

 

Add Users to the CostpointToolsGroup 
This section details the steps to add the necessary users to the newly created User Group, 
CostpointToolsGroup. The Application Tier installation that you just completed has added this group to 
your application server, granting it both Full Sharing and Full Security Permissions to the C:\Deltek 
folder and Full Security Permissions to the C:\Oracle\Middleware14.1.1 folder. 

You must complete these steps on your Costpoint 8.2 application server. 

To add users to the newly created CostpointToolsGroup: 
1. Open Computer Management. 
2. From Computer Management » Local Users and Groups » Groups, add the following users to 

the CostpointToolsGroup group: 

 Web Tier (IIS) install user: The user that will run the Web Tier install must be in this group 
prior to running that install in the next section. 

 Application Tier (Costpoint) Windows Service account: The user that you will use to start 
and run the Costpoint Windows Service. 

 Application Tier (Costpoint) Tools user: The user that you will use to log in to the 
application server to run any of the Costpoint tools, such as the Config Utility, Migrate User 
Utility, or DBWizard. 

3. Reboot your Costpoint 8.2 application server. 

Before You Start 
Make sure that you meet all Costpoint 8.2 Server Startup Prerequisites. 

Note: If you are running a WebLogic cluster, you must repeat this step for all of your WebLogic 
servers.  

Run the step once on your Cluster master and choose Primary Application Server Tier for the 
Costpoint Tier Type. Then, on each of your cluster nodes, choose Secondary Application Server 
Tier for the Costpoint Tier Type.  

For more information on WebLogic clustering. see the DeltekCostpoint82ConfigurationUtility.pdf 
technical guide. 
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Manually Start Costpoint 8.2 
This section details the steps that you use to start Costpoint 8.2. You must start the Costpoint 8.2 
WebLogic Server on your application server to gain access to the Costpoint 8.2 system. 
You must complete these steps on your Costpoint 8.2 application server. 

To start Costpoint 8.2: 
1. Right-click Start, select Search, enter Costpoint 8.2, open the file location for Start Costpoint 

8.2, right-click Start Costpoint 8.2, and click Run as administrator. 

 
This opens a Windows Command Prompt and launches a command script that starts the 
Costpoint 8.2 WebLogic Server. When the Windows Command Prompt window opens, a series of 
messages scrolls down the screen.  

Starting the Costpoint 8.2 WebLogic Server can take a long time to complete. Do not interrupt the 
process. 

2. After the Costpoint 8.2 WebLogic Server has successfully started, the following message displays 
at the bottom of the command line shell window: 

<The server started in RUNNING mode.> 
If the Costpoint 8.2 WebLogic Server encounters errors during the startup process, the message 
will not be displayed and the command line shell (DOS window) may terminate. 

If the message does not display or if the command line shell (DOS window) terminates, you must 
perform the following actions 

a. Make a copy of the C:\Deltek\Costpoint\82\logs\DEServer.log file. 

b. Contact Deltek Costpoint Technical Support. 

Install the Costpoint 8.2 Windows Service 
This section details the steps that you complete to install the Costpoint 8.2 Windows service. 

You must complete these steps on your Costpoint 8.2 WebLogic application server. 

To install Costpoint 8.2 to run as a Windows service: 
1. Stop the Costpoint 8.2 WebLogic Server. 

 
2. Use Windows Explorer to navigate to the directory where the Costpoint 8.2 software was installed 

(C:\Deltek\Costpoint\82\bin), right-click InstallCPWebasService.cmd, and select Run as 
administrator. 

Note: Due to enhanced security in Windows Server, it is advised that you use the Run as 
Administrator option when launching this command even if you have local administrative 
rights. 

Note: See the Stop Costpoint 8.2 WebLogic Server from the Web Browser section for 
information on starting and stopping the Costpoint 8.2 WebLogic Server. 
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Configure the Costpoint 8.2 Windows Service 
This section details the steps that you complete to configure the Costpoint 8.2 Windows service. 

You must complete these steps on your Costpoint 8.2 WebLogic application server. 

To configure the Costpoint 8.2 Windows service: 
1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services drop-down list, right-click the Costpoint 8.2 
service, and then click Properties on the shortcut menu. 

If you cannot find the Costpoint 8.2 service, then the service must not have installed properly in 
the previous step; you must repeat Step 1 of Install the Costpoint 8.2 Windows Service. 

3. On the Costpoint 8.2 Properties screen, click the Recovery tab and complete the following: 

Field Name Action 

First failure Change the drop-down selection from Take No Action to Restart the 
Service. 

Second failure Accept the default value, Take No Action. 

Subsequent failures Accept the default value, Take No Action. 

Reset fail count after Change the value from 0 to 1 days. 

Restart service after Accept the default value, 1 minute. 

4. Click Apply. 

5. On the Costpoint 8.2 Properties screen, click the Log On tab and complete the following. 

Field Name Action 

Account Enter the domain Account. For example, domain\useraccountname. 

If you are using a domain service login account instead of the Local 
System Account, select This Account. 

Password Enter the password for the domain Account. 

Confirm Password Re-enter the password for the domain Account. 

6. Click Apply.  

7. Make sure that the login account for the Costpoint Service is in the local Administrators group on 
the Application Tier server and is part of the local security group created by the Application Tier 
installer, CostpointToolsGroup. 

This login account must be given full access permissions for any Alternate File locations set up 
(network shared directories). Alternate File locations are used for Costpoint users, for uploading 
and downloading files from within Costpoint. 
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8. On the Costpoint 8.2 Properties screen, click the General tab, and click Start to start the 
Costpoint 8.2 service. 

The service will indicate that it started immediately. However, note that it takes several minutes 
for the Costpoint 8.2 service to fully initialize. After you start the service, wait several minutes 
before attempting to connect to the software.  

9. If you encounter problems with the Costpoint 8.2 service, check the 
C:\Deltek\Costpoint\82\logs\DEServer.log file and report any errors to Deltek Costpoint Technical 
Support. 

10. When the process completes successfully, click OK to close the Costpoint 8.2 Properties screen 
and close the Services window. 
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Web Tier Installation 
This section details the steps that you complete to integrate your Costpoint 8.2 software with the 
Microsoft Internet Information Server (IIS). 

The Microsoft Internet Information Server component is optional. The WebLogic Server software 
includes an integrated web server component that you can use with the Costpoint 8.2 software. 

Although the use of the IIS component is optional, Deltek strongly recommends that you install it in your 
production environment. In addition to acting as the proxy, the IIS server is also used to load balance the 
cluster nodes. 

Before You Start 
Make sure that you meet all Web Tier Installation/Microsoft Internet Information Server (IIS) Configuration 
Prerequisites. 

Install Microsoft IIS Web Server for Costpoint 8.2 using 
PowerShell (Admin) 
This section provides the steps that you must complete to configure Microsoft IIS prior to the installation 
of Costpoint 8.2 using PowerShell (Admin). 

 
You must complete these steps on a web server that uses the Microsoft Internet Information Server. 

To install IIS features: 
1. Open Windows PowerShell (Admin). 

2. Run this command to install features: 

Install-WindowsFeature -Name Web-Server,Web-ISAPI-Ext,Web-Mgmt-Compat,Web-
Metabase,Web-Scripting-Tools -IncludeManagementTools 

3. Run this command to verify installed features: 

get-WindowsFeature -name Web-* 

Install Microsoft IIS Web Server for Costpoint 8.2 using 
Server Manager 
This section provides the steps that you must complete to manually configure Microsoft IIS prior to the 
installation of Costpoint 8.2 using Server Manager. 

 
You must complete these steps on a web server that uses Microsoft Internet Information Server. 

Note: To manually configure using Server Manager, skip this step and proceed to the next 
step. 

Note: If you installed the required features in the previous step using PowerShell (Admin), 
you can skip this step. 
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To configure the Microsoft IIS Web server: 
1. Click Start » Programs and Features. 

2. Click the Turn Windows features on or off link. 

3. On the Server Manager screen, select Add roles and features. 

4. On the Before you begin screen, click Next >. 

5. On the Select installation type screen, accept the default of Role-based or feature-based 
installation, and click Next >. 

6. On the Select destination server, accept the default of Select a server from the server pool, 
which should have automatically selected the IIS server you are on, and click Next >. 

7. On the Select server roles screen, scroll down and select Web Server (IIS). 
8. On the Add features that are required for Web Server (IIS) screen, click Add Features. 

9. On the Select server roles screen, click Next >. 

10. On the Select features screen, click Next >. 

11. On the Web Server Role (IIS) screen, click Next >. 

12. On the Select role services screen, complete the following actions: 

a. Scroll down, expand Application Development, and select ISAPI Extensions. 

b. Scroll down; under Management Tools, expand IIS 6 Management Compatibility, and 
select IIS 6 Metabase Compatibility. 

c. Scroll down and select IIS Management Scripts and Tools. 

d. Click Next >. 

13. On the Confirm installation selections screen, click Install. 
14. After the installation is complete, click Close. 

15. From the upper right of Server Manager, click Tools, and select Internet Information Services 
(IIS) Manager. 

16. On the Internet Information Services (IIS) Manager screen, right-click your IIS computer name 
icon, and click Stop. 

17. Right-click your IIS computer name icon again and then click Start. 
18. Close the Internet Information Services (IIS) Manager window. 

19. Close the Services Manager window. 

20. Close the Control Panel window. 

Install Web Tier Software 
This section details the steps that you complete to integrate the Costpoint 8.2 system with Microsoft IIS. 

You must complete these steps on a web server that is using Microsoft Internet Information Server. 

You must have Internet access on the machine where the Costpoint 8.2 installer is invoked in order to 
download the latest DeltekCostpoint82RequirementsINI.exe file automatically. The file contains the latest 
OS platforms and database versions supported. The file is automatically downloaded when you launch 
the Web Tier installation, assuming that your web server has Internet access.  
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If your application server does not have Internet access, you must perform the steps in the Latest Installer 
Files Download Instructions section of this document before you run the DeltekCostpoint82WebTier.exe 
file. 

To install Costpoint 8.2 on your Microsoft IIS Web server: 
1. Run the DeltekCostpoint82WebTier_Buildxx.exe file to launch the Costpoint 8.2 Web Tier 

installation program.  

 
2. On the Welcome to the InstallShield Wizard for Deltek Costpoint Web screen, click Next >.  

3. On the Choose Destination Location screen, click Browse to navigate to an installation location 
for the Deltek Costpoint 8.2 IIS software.  

The default is C:\Deltek\Costpoint\82\applications (recommended). 

The installation process populates the folder selected above with a \DEWebApp folder that 
contains all the program files you need to integrate the Costpoint 8.2 software that resides on 
your application server with your Microsoft IIS Web server. 

4. Click Next >. 

5. On the Costpoint WebLogic System Information screen, complete the following fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (10.2.2.154) or hostname (appsvr01) of your 
Costpoint 8.2 WebLogic application server. 

The IP Address or Hostname must not be 127.0.1.0.1 or localhost. 

Listen Port Enter the Listener Port for your Costpoint 8.2 WebLogic application 
server. You specified this port during the Costpoint 8.2 application server 
software installation. The default port is 7009 (recommended). 

Your Microsoft IIS Web server will use the IP address or hostname and 
Listener Port information to forward requests to your Costpoint 8.2 
WebLogic application server. This port must match the one entered 
during the Costpoint 8.2 Application Server installation. 

6. Click Next >.  

7. On the Deltek Costpoint Web Tier IIS Website screen, locate the Website Name field and select 
the website where you want to create the Deltek Costpoint 8.2 Virtual Directory (CPWeb).  

Typically, this is the Default Web Site.  

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server.  

To improve security, these connections have been modified to require communication over HTTPS. 

Note: Due to enhanced security in Windows Server, it is advised that you use the Run as 
Administrator option when launching the executable files even if you have local 
administrative rights. 



Web Tier Installation 

New Installation Guide for Oracle® 54 

 

8. Click Next >. 

9. On the Pre-Installation Summary screen, review the installation parameters you have selected: 

 To change any settings, click < Back to go back and make the necessary changes.  

 If you are satisfied with the settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Do not interrupt the 
process.  

The installation will perform the scenarios detailed in the Installation Process for Costpoint 8.2, 
Web Tier Installation section of this document.  

The installation process creates the CPWeb Virtual Directory under the Default Website, using 
the Default App Pool. The process also creates a share of your Costpoint 8.2 Costpoint directory, 
C:\Deltek\Costpoint\82\applications. In order for the Application Server (WebLogic) to deploy hot 
fixes and updates, this directory must be shared with Co-Owner (Full Control) rights. 

During the installation process, a new User Group, CostpointToolsGroup, is created and given 
Full Sharing and Security rights on C:\Deltek\Costpoint\82\applications. 

Upon completion, the Deltek Costpoint Web – Installation Summary Results screen will show the 
results of the installation process.  

For each step executed, you should see either a SUCCESS message. Research any FAILED 
messages or Errors in the applicable detailed log file(s) and report the details to Deltek Costpoint 
Technical Support. 

10. Click Next >. 

11. On the InstallShield Wizard Complete screen, complete the following fields: 

Field Name Action 

Launch the installer summary file Select this checkbox to review the summary log file. 
This will show the same data from the previous screen. 

Launch the installer log file Select this checkbox to review the Deltek Costpoint 
Application installer log file. 

12. Click Finish to exit the installation. 

13. Review all log files for any Errors or reported issues. 

All Errors are captured in the AppTier_Install_ErrorSummaryResults.log, located in this folder:  
C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer. 

The following errors can be ignored when installing WebTier on the same box as your AppTier. 
ADSCreateLocalGroup Error: System.Runtime.InteropServices.COMException 
(0x82070563): The specified local group already exists. 

ADSCreateLocalGroup Error: The account already exists. Returning True 

For more information on the logs folder structure and contents, see the Post Installation Web Tier 
Installer Log Files section. 

14. Make sure that the Network Discovery and File Sharing options are switched on. 

 
Note: If you are running an IIS web cluster, you must repeat this step for all of your IIS web servers. 
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Add Users to the CostpointToolsGroup 
This section details the steps that you complete to add the necessary users to the newly created 
CostpointToolsGroup. The Web Tier installation added this group to your web server and granted the 
group Full Sharing and Full Security Permissions to the folder containing your DEWebApp folder, 
C:\Deltek\Costpoint\82\applications. 

You must complete these steps on your Costpoint 8.2 Web server. 

To add users to the newly created CostpointToolsGroup: 
1. Open Computer Management. 
2. From Computer Management, Local Users and Groups, Groups, add the following user to the 

CostpointToolsGroup group: 

 Application Tier (Costpoint) Tools user: The user that you will use to log in to the 
application server to run any of the Costpoint tools, such as the Config Utility, Migrate User 
Utility, or DBWizard. 

3. Reboot your Costpoint 8.2 Web server. 

Configure Costpoint 8.2 IIS Access 
This section details the steps that you complete to configure Costpoint 8.2 to work through IIS. 

You must complete these steps on your Costpoint 8.2 WebLogic application server. 

To configure Costpoint 8.2 and IIS: 
1. With your Costpoint 8.2 service running, right-click Start, select Search, enter Costpoint 8.2, 

right-click Start Costpoint 8.2 Config Utility, and click Run as administrator. 

 
2. On the Select Your Configuration Options screen, make sure the IIS Connection Configuration 

checkbox is selected and click Next. 
3. On the Costpoint Configuration Utility screen, click the IIS tab and perform the following for each 

of your IIS Web Servers: 

Field Name Action 

Use IIS #1 Select this checkbox. This option is cleared by default. 

Configuration File 
Location 
(iispoxy.ini) 

Click the ellipsis button and navigate to the \\CPiisServer\Costpoint 
folder share on your IIS server. 

Select the DEProxy\lib folder to access the iisproxy.ini file and click 
Open. 

When the "Configuration file iisproxy.ini was successfully loaded” 
message displays, click OK. 

Note: Due to the enhanced security in Windows Server, it is advised to that you use the Run 
as Administrator option when launching this command even if you have local administrative 
rights. 
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Field Name Action 

DEWebApp Folder 
Location 

Click the ellipsis button and navigate to the shared 
\\CPiisServer\Costpoint folder on your IIS server. 

Navigate to the folder containing your DEWebApp folder 
(\\CPiisServer\Costpoint\82\applications) and click Open. 

WebLogic Host IP Enter your WebLogic application server name. 

Port Enter the WebLogic Listener Port, 7009. 

4. Click Save.  

The following message displays: 

 
5. Click OK and then click Close. 

Restart the Costpoint 8.2 WebLogic Server 
This section details the steps that you complete to stop and restart your Costpoint 8.2 WebLogic Server. 

You must complete these steps on your Costpoint 8.2 WebLogic application server. 

To stop and restart your Costpoint 8.2 WebLogic Server: 
1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services list and Stop the Costpoint 8.2 service. 

3. After the service stops, Start the Costpoint 8.2 service. 

 
4. Close the Services window. 

Note: The service immediately indicates that it has started. However, the Costpoint 8.2 
service takes several minutes to fully initialize. After you start the service, wait several 
minutes before attempting to connect to the software. 

If you encounter problems with the Costpoint 8.2 service, check the 
C:\Deltek\Costpoint\8.2\logs\DEServer.log file and report any errors to Deltek Costpoint 
Technical Support. 
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Costpoint 8.2 Initial Log In Configuration 
This section details the steps that you complete to configure your browser and verify your Costpoint 8.2 
Application Tier and Web Tier installations. To confirm that these servers are functioning properly, you will 
log in to Costpoint 8.2 and preview a report. 

Before You Start 
Make sure that you meet all Costpoint 8.2 Initial Log In Configuration Prerequisites. 

Configure Costpoint 8.2 Printer 
This step is optional. It provides configuration instructions for your Application Tier WebLogic Server to 
allow you to print Costpoint 8.2 reports. This is useful for asynchronous printing from the server, 
especially for tasks such as printing reports through the Job Server in the middle of the night. 

 
You must complete these steps on your Costpoint 8.2 application server. 

To create Windows printer objects on your application server: 
1. Right-click Start, click Control Panel, and under Hardware, select View devices and printers. 

2. On the Printers and Faxes screen, double-click Add Printer. 
3. Use the Add Printer Wizard to create a Windows printer object that will connect and print to a 

printer on your network. 

On your application server, you can create as many Windows printer objects as needed for your 
organization. After the printer objects are created, your Costpoint 8.2 WebLogic application server 
makes the printer objects available to your users. 

Log In to Costpoint 8.2 
This section details the steps that you complete to log in to Costpoint 8.2. 

You can perform these steps from any Windows client workstation that has TCP/IP access to your 
Costpoint 8.2 WebLogic application server. 

 

To log in to Costpoint 8.2: 
1. Open your web browser, and enter one of the following URLs: 

http://<AppServerIPAddress or ComputerName>:<Port> 

http://<WebServerIPAddress or ComputerName>/cpweb 

Note: Users can print to local printers from the workstations without configuring anything in this step. 

Note: Depending on your environment, you may need to add your Costpoint 8.2 URL under Local 
Internet instead of Trusted sites. 

Disable any pop-up blockers, or explicitly allow pop-ups for the Costpoint 8.2 URL, such as 
http://<IPAddress or ComputerName>, where <IPAddress or ComputerName> identifies your 
Costpoint 8.2 WebLogic application server or IIS Web server (for example, http://10.2.2.154). 

http://10.2.2.154/
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Where <AppServerIPAddress or ComputerName> identifies your Costpoint 8.2 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 8.2 WebLogic 
application server uses to listen for connections. You specified this port value during the 
Costpoint 8.2 software installation. The default is 7009 (for example, http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 8.2 IIS Web server 
(for example, http://10.2.2.156/cpweb). 

2. When the Deltek Costpoint 8.2 Welcome screen displays, complete the following fields. 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter password. The password is case-sensitive and must be 
entered in lowercase letters. Passwords that you create for other 
user IDs can consist of uppercase, lowercase, or mixed letters. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name that you assigned to your Costpoint 
8.2 system during the Application Server installation. Typically, 
customers use a system name that is identical to their Costpoint 
8.2 Database name, DELTEKCP. 

ADDITIONAL CRITERIA Click + to display these additional fields: 

 Application: Accept the blank default value or enter a 
specific Costpoint 8.2 application. For example, 
COSTPOINT MENU. 

 Company: Enter your company ID. For example, 1. 

 Validation Frequency: Accept the default drop-down 
value, Field. After you successfully log in to Costpoint 8.2, 
review the online help for a detailed explanation of the 
values that you can select for this field. 

 Language: Accept the default drop-down value, English, 
or change to your language. 

Remember me Select this checkbox to have the system remember your login 
information. This checkbox is not selected by default. 

3. Click Log In. 

4. When the Your password has expired screen displays, complete the following. 

Field Name Action 

Current Password Enter password. The password is case-sensitive and must be 
entered in lowercase. 

New Password Enter a new password for the CPSUPERUSER account. 
Passwords are case-sensitive and may consist of uppercase, 
lowercase, or mixed letters. 
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Field Name Action 

Confirm Password Re-enter your new password for CPSUPERUSER. 

5. Click Log In. 

6. From the main menu screen, click Admin » System Administration » Printing » Manage 
System Printers. 

 
7. On the Manage System Printers screen displays, click New Record (+).  
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8. Complete the following fields: 

Field Name Action 

Printer ID Click the magnifying glass (circled above in red). This displays all 
printer objects that are available on your Application Server. Select the 
appropriate printer object by clicking the checkbox to the left of the 
printer object name and then clicking SELECT. 

Printer Name Enter a descriptive name for the printer object. 

9. Select the Assigned Users/User Groups link located in the lower-right corner of the System 
Printers section. 

10. When the focus switches to the Assigned Users/User Groups section at the bottom half of your 
browser window, click New Record (+), and complete the following fields: 

Field Name Action 

User/User Group ID 
or User/User Group 
Name 

Click the magnifying glass for one of these fields. Select a User/User 
Group that should have access to the printer object you specified 
above. 

Company Click the magnifying glass. Select a Company for this User/User 
Group. 

11. Click SELECT. You must repeat Step 9 for each User/User Group that you want to assign the 
printer object that you specified earlier. 

12. Click Save. 

13.  When the “Record modifications completed without error” message is displayed, click OK 

You must repeat items 6–12 for any printer objects on your Application server that you want to 
make available to your Costpoint 8.2 system users. 

14. Click File» Log-out to exit Costpoint 8.2.  

15. Close your browser. 

Verify Your Costpoint 8.2 Printer Configuration 
This section details the steps that you complete to verify your Costpoint 8.2 printers. 

This step can be performed from any Windows client workstation that has TCP/IP access to your 
Costpoint 8.2 WebLogic application server. 

To verify your Costpoint 8.2 printers: 
1. Open your Web browser, and enter one of the following URLs: 

http://<AppServerIPAddress or ComputerName>:<Port> 

http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 8.2 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 8.2 WebLogic 
application server uses to listen for connections. You specified this port value during the 
Costpoint 8.2 software installation. The default is 7009 (for example, http://10.2.2.154:7009). 
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Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 8.2 IIS Web server 
(for example, http://10.2.2.156/cpweb). 

2. On the Deltek Costpoint screen, complete the following fields: 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter the CPSUPERUSER user password. The default was 
password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 8.2 system 
during the Application Server Installation process. Typically, customers 
use a system name that is identical to their Costpoint 8.2 Database 
name, DELTEKCP. 

SHOW ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value or enter a specific 
Costpoint 8.2 application. For example, COSTPOINT MENU. 

 Company: Enter your company ID. For example, 1. 

 Validation Frequency: Accept the default drop-down value, 
Field. After you have successfully logged in to Costpoint 8.2, 
review the online help for a detailed explanation of the value you 
can select for this field. 

Remember log in 
information 

Select this checkbox to have the system remember your login 
information. This option is not selected by default. 

3. Click Log In.  

4. From the main menu screen, click Admin » Security » Security Reports/Inquiries » Print User 
Group Rights Report. 
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5. On the Print User Group Rights Report screen, click Print Options. 

 
6. On the Print Options screen, select the System Printer or the Local Printer Delivery Option, 

depending on how you set up your Application Server printer, and click OK. 

7. On the Print User Group Rights Report screen, click Print Default Report. 



Costpoint 8.2 Initial Log In Configuration 

New Installation Guide for Oracle® 63 

 

 
If the User Group Rights Report prints correctly, your Costpoint 8.2 Application Server printer 
setup is working properly. If the report does not print correctly, contact Deltek Costpoint Technical 
Support. 

8. Click File » Close Application to close the Print User Group Rights Report screen. 

9. Click OK when the following message displays:  

“You have unsaved changes. Select Cancel to go back and save changes or select OK to discard 
changes and close the application”.  

You can now begin to configure and use the Costpoint 8.2 system.  

For a list of all documentation included with the Costpoint 8.2 release, see the Related 
Documentation section. 

Deltek strongly recommends that you change the password for your CPSUPERUSER. For 
instructions, see the Change CPSUPERUSER User’s Password section. 

Deploy Costpoint as a Progressive Web App  
A Progressive Web App (PWA) is a web application that uses a set of technologies to incorporate the 
features historically associated with either browser or native applications. As a result, the PWA provides 
the end user with the best of both worlds.  

The Costpoint PWA application provides the same set of capabilities regardless of the device. For 
example, if your company configured SAML or FIDO authentication for desktops, that authentication will 
work on mobile devices as well, with no extra steps, additional deployment, or configuration necessary. If 
you developed an Extension, that Extension will work on a desktop, tablet, or phone. If your users access 
Costpoint from your company Azure portal using SSO, then Costpoint will work on a laptop or phone, as 
well. 

As Costpoint is being constantly enhanced, you can be confident that your company and your users will 
always have access to the latest features and functionality while using Costpoint PWA, regardless of the 
device used to access Costpoint. 
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From an IT perspective, Costpoint PWAs on mobile devices provide these additional benefits: 

 The instructions to install Costpoint PWA on your device (similar to installing a native app from a 
store) describe a manual process. However, because it is not required to publish PWA 
applications to the store, IT can push Costpoint PWA application to your employee devices using 
standard MDM solutions (for example, MobileIron). 

 If your company has an internal company store that employees should use to download 
applications (for example, using a MobileIron store), a PWA application can be published in your 
company store.  

 Your IT team has full control over the version of Costpoint used by your employees, including the 
PWA application deployed to user devices. When your company IT team or the Deltek Cloud 
team deploys updates to Costpoint, the PWA applications on user devices are refreshed 
automatically and seamlessly, always staying in sync with the version of Costpoint used by your 
organization. 

 There is no need to worry about backward or forward compatibility issues with the version of 
applications deployed on user devices, and no need to ask or expect users to download an 
updated version of the application from the company store. 

 

Deploy the Costpoint PWA on an Android Device 
You can install the Costpoint PWA from the Costpoint Login page or the Chrome browser menu. 

To deploy the Costpoint PWA via the Costpoint Login page: 
1. On your Android device, open the Costpoint Login page in the Chrome browser. 

2. Tap Add to Home screen. 

3. Name the Costpoint PWA, and then click Add. 

You can now tap the icon on your Home screen to launch Costpoint as a stand-alone web app. 

To deploy the Costpoint PWA via the Chrome browser menu: 
1. On your Android device, open the Costpoint Login page in the Chrome browser. 

2. Tap the menu (three vertical dots) in the upper-right corner. 

3. Tap Add to Home screen. 

4. Tap Add. 

You can now tap the icon on your Home screen to launch Costpoint as a stand-alone web app. 

Deploy the Costpoint PWA on an iPhone or iPad 

To deploy the Costpoint PWA on an iPhone or iPad: 
1. On your iPhone or iPad, open the Costpoint Login page in the Safari browser. 

2. Tap the Share button in Safari. 

Note: Deploying a PWA application using the steps outlined below not only creates an icon on your 
home screen but also generates a real native application container on your device. For example, you 
can tap the standard App info option for the Costpoint icon on an Android device and it will show that 
the CP icon you just created is a native application, downloaded from the Google Play store. 
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3. Tap the Add to Home Screen icon. 

4. Name the Costpoint PWA. 

5. Tap Add in the upper-right corner. 

You can now tap the icon on your Home screen to launch Costpoint as a stand-alone web app. 

Deploy the Costpoint PWA on a Desktop  
Deploying the Costpoint PWA on your desktop creates a desktop shortcut to the application. When you 
access Costpoint using the app, more data is visible on your screen. Browser elements, such as the 
address bar, tabs, and other controls, are removed, offering a clearer view of your Costpoint data.  

 

To deploy the Costpoint PWA in Google Chrome: 
1. Open the Costpoint Login page. 

2. Install Costpoint PWA using one of the following three options: 

 In the Address bar, click + (Install Costpoint) » Install. 
 In the browser menu (three vertical dots), click Install Costpoint » Install. 
 On the Costpoint Login page, click Add to Home Screen » Install. 

Note: Support for Microsoft Edge is coming soon. 
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Maintenance Release Installation 

Apply Latest Costpoint 8.2 Maintenance Release (MR) 
After you have a functioning Costpoint 8.2 environment, follow the instructions in the 
DeltekCostpoint82MaintenanceReleaseInstallation.pdf installation document to install the latest 
Costpoint 8.2 maintenance release (MR). 
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Post-Installation Configuration 

Database Tier Installer Log Files 
Database Tier Installation logs are written to the following folder: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer 
Each of these log files are detailed in the table below, but here is a look at the log folder/file structure: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer 

DBTier_Install.log 

DBTier_Install_ErrorSummaryResults.log 

DBTier_Install_SummaryResults.log 

DatabaseSteps.txt 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_ADMIN 

createLinkUser.bat_CP_ADMIN.log 

OracleNewAdminDatabaseSetup82.bat.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_SYSTEM 

createLinkUser.bat_CP_SYSTEM.log 

OracleNewSystemDatabaseSetup82.bat.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_TRANS 

createLinkUser.bat_CP_TRANS.log 

OracleNewTransactionDatabaseSetup82.bat.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\PL_TRANS 

createLinkUser.bat.log 

CreatePLUserInCPTran.bat.log 

CreatePLUserInTETran.bat.log 

OracleNewPLDatabaseSetup82.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\TE_TRANS 

createLinkUser.bat_TE_TRANS.log 

CreateTEUserInCPTran.bat_TE_TRANS.log 

OracleNewTEDatabaseSetup82.bat.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\XA_TRANS 

MSDTC.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\InstallerLogArchive 
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Log Name Description What to Look For 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer 

DBTier_Install.log Main DB Tier installation Log File. 
Shows detailed results of all 
processes executed in the installer. 

(Multiple log files for this, older ones 
from previous DB Tier installer runs 
stored under InstallerLogArchive 
folder.) 

Date and Build number 
at the top, Installation 
Success or failed at the 
bottom. Installation 
details, Error or Failed 
messages in between. 

DBTier_Install_SummaryResults.log Installer Summary description Panel 
output written to a log file. Contains 
the results of the installation process.  

(Multiple log files for this, older ones 
from previous DB installer runs stored 
under InstallerLogArchive folder.) 

SUCCESS items, 
FAILED items with error 
messages, and/or 
Warning messages. 

DBTier_Install_ErrorSummaryResults.log DB Tier installer error output written to 
a log file. Contains any ERROR 
results of the installation process.  

(Multiple log files for this, older ones 
from previous DB installer runs stored 
under InstallerLogArchive folder.) 

Any errors during the 
installation will be written 
to this file. This will then 
lead you to the other 
logs for more detailed 
description of the errors. 

DatabaseSteps.txt   

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_ADMIN 

createLinkUser.bat_CP_ADMIN.log Results of creating CPLINK_USER in 
CPADMIN schema. 

Will show any issues, 
that it completed 
successfully, or that the 
login already exists. 

OracleNewAdminDatabaseSetup82.bat.log Detailed results for setting up the 
CPADMIN user and schema. 

Will show any issues or 
$DBSUCCESS=TRUE 
at the end of the log file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_SYSTEM 

createLinkUser.bat_CP_SYSTEM.log Results of creating CPLINK_USER in 
CPSYSTEM schema. 

Will show any issues, 
that it completed 
successfully, or that the 
login already exists. 

OracleNewSystemDatabaseSetup82.bat.log Detailed results for setting up the 
CPSYSTEM user and schema. 

Will show any issues or 
$DBSUCCESS=TRUE 
at the end of the log file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_TRANS 

createLinkUser.bat_CP_TRANS.log Results of creating CPLINK_USER in 
CPTRANS schema. 

Will show any issues, 
that it completed 
successfully, or that the 
login already exists. 
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Log Name Description What to Look For 

OracleNewTransactionDatabaseSetup82.bat.log Detailed results for setting up the 
CPTRANS user and schema. 

Will show any issues or 
$DBSUCCESS=TRUE 
at the end of the log file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\PL_TRANS 

createLinkUser.bat.log Results of creating CPLINK_USER in 
TETRANS schema. 

Will show any issues, 
that it completed 
successfully, or that the 
login already exists. 

CreatePLUserInCPTran.bat.log Results of creating PLTRANS user in 
CPTRANS schema. 

Will show any issues, 
that it completed 
successfully, or that the 
login already exists. 

CreatePLUserInTETran.bat.log Results of creating PLTRANS user in 
TETRANS schema. 

Will show any issues, 
that it completed 
successfully, or that the 
login already exists. 

OracleNewPLDatabaseSetup82.log Detailed results for setting up the 
PLTRANS user and schema. 

Will show any issues or 
$DBSUCCESS=TRUE 
at the end of the log file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\TE_TRANS 

createLinkUser.bat_TE_TRANS.log Results of creating CPLINK_USER in 
CPTRANS schema. 

Will show any issues, 
that it completed 
successfully, or that the 
login already exists. 

CreateTEUserInCPTran.bat_TE_TRANS.log Results of creating TETRANS user in 
CPTRANS schema. 

Will show any issues, 
that it completed 
successfully, or that the 
login already exists. 

OracleNewTEDatabaseSetup82.bat.log Detailed results for setting up the 
TETRANS user and schema. 

Will show any issues or 
$DBSUCCESS=TRUE 
at the end of the log file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\XA_TRANS 

MSDTC.log Results of restating the Distributed 
Transaction Coordinator. 

Will show any issues or 
that it completed 
successfully. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\InstallerLogArchive 

 Copies of current log files will get 
moved to these folders if more than 
one run of the DB Tier installer is 
done. 
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Application Tier Installer Log Files 
Application Tier Installation logs are written to the following folder: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer 
Each of these log files are detailed in the table below, but here is a look at the log folder/file structure: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer 

AppTier_Install.log 

AppTier_Install_ErrorSummaryResults.log 

AppTier_Install_SummaryResults.log 

AppTierSteps.txt 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer\APIs 

applyLicense_<name of license zip file>.log 

applyLicense_<name of license zip file>result.log 

linkViews.log 

linkViewsResultCode.log 

OrgSecByApplMod.log 

OrgSecByApplModResult.log 

syncSysSettingsTable.log 

syncSysSettingsTableResultCode.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer\InstallerLogArchive 

The following table provides the list of log files generated during the App Tier Installation, the folder they 
are under, along with a description of each, as well as what to look for when reviewing them: 

Log Name Description What to Look For 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer 

AppTier_Install.log Main App Tier installation Log File. 
Shows detailed results of all 
processes executed in the installer. 

(Multiple log files for this, older ones 
from previous App Tier installer runs 
stored under InstallerLogArchive 
folder.) 

Date and Build number 
at the top, Installation 
Success or failed at the 
bottom. Installation 
details, Error or Failed 
messages in between. 

AppTier_Install_SummaryResults.log Installer Summary description Panel 
output written to a log file. Contains 
the results of the installation process.  

(Multiple log files for this, older ones 
from previous App installer runs 
stored under InstallerLogArchive 
folder.) 

SUCCESS items, 
FAILED items with error 
messages, and/or 
Warning messages. 
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Log Name Description What to Look For 

AppTier_Install_ErrorSummaryResults.log App Tier installer error output written 
to a log file. Contains any ERROR 
results of the installation process.  

(Multiple log files for this, older ones 
from previous App installer runs 
stored under InstallerLogArchive 
folder.) 

Any errors during the 
installation will be written 
to this file. This will then 
lead you to the other 
logs for more detailed 
description of the errors. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer\APIs 

applyLicense_<name of license zip file>.log Results of applying your license file. Details of applying 
License file.  If no issues 
will see this at the 
bottom: 

>License file applied 
successfully... 

-->Rebuilding Licensed 
Applications... 

-->Rebuilding User 
Menus... 

-->Done. 

-->Removing temporary 
folder... 

-->End of the process. 

applyLicense_<name of license zip file>result.log Results of applying your license file. Will show 1 if successful 
or 0 if there were issues. 

linkViews.log Log file containing details of Link 
Views process. 

Will show error details if 
any at bottom. 

linkViewsResultCode.log Results of applying link views. Will show 1 if successful 
or 0 if there were issues. 

OrgSecByApplMod.log Log file containing details of 
populating the Org Security Tables. 

Will show error details if 
any at bottom. 

OrgSecByApplModResult.log Results of populating the Org 
Security Tables. 

Will show 1 if successful 
or 0 if there were issues. 

syncSysSettingsTable.log Log file containing details of syncing 
the System Settings Tables. 

Will show error details if 
any at bottom. 

syncSysSettingsTableResultCode.log Results of syncing System Settings 
Tables. 

Will show 1 if successful 
or 0 if there were issues. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer\InstallerLogArchive 

 Copies of current log files will get 
moved to these folders if more than 
one run of the App Tier installer is 
done. 
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Web Tier Installer Log Files 
Web Tier Installation logs are written to the following folder: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer 
Each of these log files are detailed in the table below, but here is a look at the log folder/file structure: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer 

DeltekCostpointWebTierSetup.log 

WebTier_Setup_ErrorSummaryResults.log 

WebTier_Setup_SummaryResults.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer\InstallerLogArchive 

The following table provides the list of log files generated during the Web Tier Installation, the folder they 
are under, along with a description of each, as well as what to look for when reviewing them: 

Log Name Description What to Look For 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer 

DeltekCostpointWebTierSetup.log Main Web Tier installation Log File. 
Shows detailed results of all 
processes executed in the installer. 

(Multiple log files for this, older ones 
from previous Web installer runs 
stored under InstallerLogArchive 
folder.) 

Date and Build number 
at the top, Installation 
Success or failed at the 
bottom. Installation 
details, Error or Failed 
messages in between. 

WebTier_Setup_SummaryResults.log Installer Summary description Panel 
output written to a log file. Contains 
the results of the installation process.  

(Multiple log files for this, older ones 
from previous Web installer runs 
stored under InstallerLogArchive 
folder.) 

SUCCESS items, 
FAILED items with error 
messages, and/or 
Warning messages. 

WebTier_Setup_ErrorSummaryResults.log Web Tier installer error output written 
to a log file. Contains any ERROR 
results of the installation process.  

(Multiple log files for this, older ones 
from previous Web installer runs 
stored under InstallerLogArchive 
folder.) 

Any errors during the 
installation will be written 
to this file. This will then 
lead you to the other 
logs for more detailed 
description of the errors. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer\InstallerLogArchive 

 Copies of current log files will get 
moved to these folders if more than 
one run of the Web Tier installer is 
done. 
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WebLogic Server Configuration 
This section details the following methods to start and stop your Costpoint 8.2 WebLogic Server: 

 Starting the Costpoint 8.2 WebLogic Server as a Windows service 

 Starting the Costpoint 8.2 WebLogic Server from the Windows Start menu 

 Starting the Costpoint 8.2 WebLogic Server from a Windows Command Prompt 

 Stopping the Costpoint 8.2 WebLogic Server as a Windows service 

 Stopping the Costpoint 8.2 WebLogic Server from a web browser 

Start Costpoint 8.2 WebLogic Server as a Windows Service 
This section details the steps that you complete to start your Costpoint 8.2 WebLogic Server as a 
Windows service. 

You must complete these steps on your Costpoint 8.2 WebLogic application server. 

To start your Costpoint 8.2 WebLogic Server when it is installed as a Windows service: 
1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services list, right-click the Costpoint 8.2 service, and 
click Properties on the shortcut menu. 

3. On the Costpoint 8.2 Properties screen, click the General tab. 

4. Click Start to start the Costpoint 8.2 service. 

The service will indicate that it started immediately. However, the Costpoint 8.2 service takes 
several minutes to fully initialize. After starting the service, wait several minutes before attempting 
to connect to the software. 

If you encounter problems with the Costpoint 8.2 service, check the 
C:\Deltek\Costpoint\82\logs\DEServer.log file and report any errors to Deltek Costpoint Technical 
Support. 

5. Click OK to close the Costpoint 8.2 Properties screen. 

6. Close the Services window. 

Start Costpoint 8.2 WebLogic Server from the Start Menu 
This section details the steps that you complete to start your Costpoint 8.2 WebLogic Server from the 
Windows Start menu. 
You must complete these steps on your Costpoint 8.2 WebLogic application server. 

To start your Costpoint 8.2 WebLogic Server from the Windows Start menu: 
1. Right-click Start, select Search, enter Costpoint 8.2, right-click Start Costpoint 8.2, and click 

Run as administrator. 

 

Note: Due to the enhanced security in Windows Server, it is advised that you use the Run as 
Administrator option when launching this command even if you have local administrative 
rights. 
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This will open a Windows Command Prompt and launch a command script that starts the 
Costpoint 8.2 WebLogic Server. When the Windows Command Prompt window opens, a series of 
messages scroll down the screen. 

The Costpoint 8.2 WebLogic Server takes several minutes to start. 

 If your Costpoint 8.2 WebLogic Server starts successfully, the following message displays on 
the lower portion of the command line shell window: 

<The server started in RUNNING mode. > 

 If your Costpoint 8.2 WebLogic Server encounters errors during the startup process, the 
message will not display, and the command line shell (DOS window) may terminate. 

2. If you do not receive the message indicating that the process completed successfully, or the 
command line shell (DOS window) terminates, you should: 

a. Make a copy of the C:\Deltek\Costpoint\82\logs\DEServer.log file. 

b. Contact Deltek Costpoint Technical Support. 

Start the Costpoint 8.2 WebLogic Server from the Windows Command 
Prompt 
This section details the steps that you complete to start your Costpoint 8.2 WebLogic Server from a 
Windows Command Prompt. 

You must complete these steps on your Costpoint 8.2 WebLogic application server. 

To start your Costpoint 8.2 WebLogic Server from a command line shell: 
1. Open a Windows Command Prompt in Administrator Mode, navigate to the 

C:\Deltek\Costpoint\82\bin folder, and launch the following command script: 

StartCPWeb 

A series of messages scrolls down the screen. It takes several minutes for the Costpoint 8.2 
WebLogic Server to start. 

 If your Costpoint 8.2 WebLogic Server starts successfully, the following message displays on 
the lower portion of the command line shell window: 

<The server started in RUNNING mode. > 

 If your Costpoint 8.2 WebLogic Server encounters errors during the startup process, the 
message does not display and the command line shell (DOS window) may terminate. 

2. If you do not receive the message indicating that the process completed successfully, or the 
command line shell (DOS window) terminates, you should: 

a. Make a copy of the C:\Deltek\Costpoint\82\logs\DEServer.log file. 

b. Contact Deltek Costpoint Technical Support. 

Stop the Costpoint 8.2 WebLogic Server as a Windows Service 
This section details the steps that you complete to stop your Costpoint 8.2 WebLogic Server when it is 
running as a Windows service. 

You must complete these steps on your Costpoint 8.2 WebLogic application server. 
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To stop your Costpoint 8.2 WebLogic Server when it is installed as a Windows service: 
1. Click Windows Start » Administrative Tools » Services. 

2. On the Services window opens, scroll down the Services list, right-click the Costpoint 8.2 
service, and click Properties on the shortcut menu. 

3. On the Costpoint 8.2 Properties screen, click the General tab. 

4. Click Stop to stop the Costpoint 8.2 service. 

5. Click OK to close the Costpoint 8.2 Properties screen. 

6. Close the Services window. 

Stop Costpoint 8.2 WebLogic Server from the Web Browser 
This section details the steps that you complete to stop your Costpoint 8.2 WebLogic Server from the 
WebLogic console. 

You must complete these steps from a machine that has web browser client access via TCP/IP to the 
Costpoint 8.2 WebLogic application server. 

To stop your Costpoint 8.2 WebLogic Server from a web browser: 
1. Open your Web browser and enter the following case-sensitive URL: http://<IPAddress or 

ComputerName>:<Port>/console 

Where <IPAddress or ComputerName> identifies your Costpoint 8.2 WebLogic application 
server and <Port> identifies the unique port number that your Costpoint 8.2 WebLogic application 
server uses to listen for connections. You specified this port value during the Costpoint 8.2 
software installation. The default port is 7009 (for example, http://10.2.2.154:7009/console). 

2. When the WebLogic Server Administration Console screen displays, complete the following 
fields: 

Field Name Action 

Username Enter system. 

Password Enter the password for the WebLogic Administrative user. The default 
password is weblogic. 

3. Click Login. 

4. On the Welcome system screen, in the left pane, under Domain Structure, select the delteke 
node of the hierarchical tree. 

5. On the Settings for delteke screen, click the Control tab. 

6. Select the checkbox to the left of the DEServer(admin) field. 

7. Click Shutdown, and then click Force Shutdown Now. 

8. When the Domain Life Cycle Assistant screen displays, click Yes. 

9. Close the web browser. 
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Change CPSUPERUSER User’s Password 
This section details the steps that you complete to change the CPSUPERUSER users password. 

You can complete these steps from any Windows client workstation that has TCP/IP access to your 
Costpoint 8.2 WebLogic application server. 

To change the CPSUPERUSER user’s password: 
1. Open your web browser, and enter one of the following URLs: 

http://<AppServerIPAddress or ComputerName>:<Port> 

http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 8.2 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 8.2 WebLogic 
application server uses to listen for connections. You specified this port value during the 
Costpoint 8.2 software installation. The default is 7009 (for example, http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 8.2 IIS Web server 
(for example, http://10.2.2.156/cpweb). 

2. On the Deltek Costpoint screen, complete the following fields. 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter the password for the CPSUPERUSER user. The default is 
password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 8.2 system 
during the Application Server Installation process. Typically, customers 
use a system name that is identical to their Costpoint 8.2 Database 
name, DELTEKCP. 

SHOW 
ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value or enter a specific 
Costpoint 8.2 application. For example, COSTPOINT MENU. 

 Company: Enter your company ID. For example, 1. 

 Validation Frequency: Accept the default drop-down value, Field. 
After you successfully log in to Costpoint 8.2, review the online 
help for a detailed explanation of the values that you can select for 
this field. 

Remember log in 
information 

Select this checkbox to have the system remember your login 
information. This option is not selected by default. 

3. Click Log In. 

4. From the main menu screen, click Admin » Security » System Security » Manage Users. 
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5. On the Manage Users screen, click Query. 

 
6. On the Users screen, enter CPSUPERUSER in the ID field, and click Find. 



Post-Installation Configuration 

New Installation Guide for Oracle® 78 

 

 
7. After the CPSUPERUSER user information loads on the Manage Users screen, click the 

Authentication tab and complete the following fields.  

Field Name Action 

Authentication 
Method 

Accept the default value, Costpoint Database, from the drop-down 
list. 

Costpoint Password Enter a password for the CPSUPERUSER user.  

The password is case-sensitive and must be between 8 and 20 
characters in length. 

Verify Password Re-enter the password for the CPSUPERUSER user. 

8. Click Save. 

9. After the confirmation message is displayed at the bottom of the screen, click File » Close 
Application to close the Enter/Manage Users screen. 

10. Click File » Log-out to exit Costpoint 8.2.  

11. Close your web browser. 

12. Open your web browser, and enter one of the following URLs: 

http://<AppServerIPAddress or ComputerName>:<Port> 

http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 8.2 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 8.2 WebLogic 
application server uses to listen for connections. You specified this port value during the 
Costpoint 8.2 software installation. The default is 7009 (for example, http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 8.2 IIS Web server 
(for example, http://10.2.2.156/cpweb). 
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13. On the Deltek Costpoint screen, complete the following fields. 

Field Name Action 

Username Enter CPSUPERUSER 

Password Enter the CPSUPERUSER user’s password. The default is password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 8.2 system 
during the Application Server Installation process. Typically, customers 
use a system name that is identical to their Costpoint 8.2 Database 
name, DELTEKCP. 

SHOW ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value or enter a specific 
Costpoint 8.2 application. For example, COSTPOINT MENU. 

 Company: Enter your company ID. For example, 1. 

 Validation Frequency: Accept the default drop-down value, 
Field. After you successfully log in to Costpoint 8.2, review the 
online help for a detailed explanation of the values that you can 
select for this field. 

Remember log in 
information 

Select this checkbox to have the system remember your login 
information. It is selected by default. 

14. Click Log In. 

You may begin accessing and using the Costpoint 8.2 system. 

If you are unable to log in to Costpoint 8.2, contact Deltek Costpoint Technical Support. 

Secure Sockets Layer (SSL) Encryption with Costpoint 8.2 
Implementation 
Information regarding the Costpoint Web support for SSL encryption is detailed in this section. This 
section also provides references to additional resources that you can use to learn more about 
implementing SSL with Costpoint 8.2. 

Costpoint Web’s Support for SSL 
Costpoint 8.2 was tested against, and supports, SSL implemented on its WebLogic Server and Microsoft 
Internet Information Server (IIS) components. 

 
SSL requirements will vary from customer to customer. Consequently, this section does not provide 
specific instructions for implementing SSL on either your WebLogic Server or IIS components. Instead, 

Note: The IIS component is optional in the Costpoint Web environment. If you have chosen to deploy 
IIS with your Costpoint Web environment, you can implement SSL on both your IIS and WebLogic 
Server components. 
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this section provides third-party informational resources that you can use to learn about and implement 
SSL with your Costpoint 8.2 environment. 

Informational Resources for Implementing SSL 
You can implement SSL on either or both of your Costpoint 8.2 system’s IIS and WebLogic Server 
components. For help on implementing SSL, please refer to the following URLs: 

 WebLogic Server 

 http://docs.oracle.com/cd/E24329_01/web.1211/e24422/ssl.htm#SECMG384: Oracle 
WebLogic Server documentation that provides an overview of WebLogic’s domestic- and 
exportable-strength SSL licenses as well as step-by-step instructions for implementing SSL 
on your WebLogic Server. 

 IIS 

 http://technet.microsoft.com/en-us/library/cc732230(WS.10).aspx: Microsoft TechNet article 
that provides an overview of using encryption with IIS 8.2 and specific instructions for 
configuring SSL. 

 http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-
deed-4056-9592-e721a4889a71.mspx?mfr=true: Microsoft TechNet article that provides an 
overview of using encryption with IIS 6.0 and specific instructions for configuring SSL. 

In addition to consulting these informational resources, you can contact Deltek’s Systems Solutions team 
to arrange assistance for implementing SSL with your Costpoint 8.2 system. 

Adding New Oracle Costpoint Systems to Existing 
Application Tier 

 

To add a brand new Costpoint 8.2 system on Oracle RDBMS to an existing Application Tier: 
1. Execute the Costpoint 8.2 Database Tier installer and create your Costpoint 8.2 schemas. 

2. Add the new Costpoint 8.2 system through the Costpoint 8.2 Config Utility. Include Time & 
Expense and Planning schemas when creating the Costpoint system if you are licensed to use 
them. 

3. Execute Link-Views using the Costpoint 8.2 DBWizard. 

4. Apply your Costpoint/Time & Expense/Planning license(s) to the new system using the Costpoint 
8.2 DBWizard, Apply License option. 

5. Execute Link-Views using the Costpoint 8.2 DBWizard. 

6. Execute and compile invalid objects in your Time and Expense schema.  

Deltek provides a script called CompileSchemaObjectsAfterLinkViews.sql, which is packaged and 
available under your DB Tier Time & Expense installation folder. 

C:\Deltek\Costpoint\82\Database\Scripts\ORACLE\TE_TRANSACTION\Scripts\CompileSch
emaObjectsAfterLinkViews.sql 

Note: This section is only applicable if you use the Costpoint 8.2 New Database Tier installer to 
create new Costpoint 8.2 schemas. 

This section does not apply if you are not licensed to use Time and Expense, Planning, or both. 

http://docs.oracle.com/cd/E24329_01/web.1211/e24422/ssl.htm#SECMG384
http://technet.microsoft.com/en-us/library/cc732230(WS.10).aspx
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-deed-4056-9592-e721a4889a71.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-deed-4056-9592-e721a4889a71.mspx?mfr=true
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7. Execute and compile invalid objects in your Planning schema.  

Deltek provides a script called CompileSchemaObjectsAfterLinkViews.sql. This script is packaged 
and available under your DB Tier Planning installation folder. 

C:\Deltek\Costpoint\82\Database\Scripts\ORACLE\PL_TRANSACTION\Scripts\CompileSch
emaObjectsAfterLinkViews.sql 

Download the Latest Installer Files 
The Costpoint Database Tier installer provides certain command-line options that can be invoked in 
special circumstances.  

To display the currently supported switches: 
1. Open Command Prompt in Administrator Mode 

2. Navigate to the directory where the installer is located 

3. Enter the following: DeltekCostpoint82DatabaseTier_Buildxx.exe /? 

This section details the instructions that you complete to download the latest Costpoint 8.2 Database 
upgrade and the DeltekCostpoint82RequirementsINI files. If your servers have internet access, each 
installer will automatically download the applicable files. If your servers do not have Internet access, you 
must run this step for each installer. 

You must complete these steps on any machine that has Internet access. 

To download the required upgrade files: 
1. Run the applicable command to retrieve the files from DSM: 

DeltekCostpoint82DatabaseTier_Build01.exe /filedynamicdownload 
DeltekCostpoint82ApplicationTier_Build01.exe /filedynamicdownload 
DeltekCostpoint82WebTier_Build01.exe /filedynamicdownload 
You will see a screen similar to the following. 
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2. After the file downloads, when you receive a message similar to the following, click OK. 

     
3. Copy the downloaded DeltekCostpoint82DatabaseNewInstallationFiles.exe/ 

DeltekCostpoint82RequirementsINI.exe file(s) to your server, in the same folder as your ‘.exe’ 
installer file.  

 

 



 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 
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